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List of Abbreviations

AUT automated ultrasonic testing
CAD computer-aided design
ED electronic delay
EMAT electro-magnetic acoustic transducer
GB gigabyte
GD global delay
ID inside diameter
LCP lack of cross-penetration
LD law delay
LHS left-hand side
LW longitudinal wave
MB megabyte
NDT non destructive testing
OD outside diameter
PA phased array
PCS probe center separation
RAM random-access memory
RHS right-hand side
SW shear wave
TOFD time-of-flight diffraction
USB universal serial bus
UT ultrasonic testing
WD wedge delay
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Important Information — Please Read Before Use

Carefully read the following important information before installing the NDT 
SetupBuilder software and configuring the inspection setups.

Intended Use

The NDT SetupBuilder software is designed to create inspection setups for 
nondestructive ultrasonic inspections of industrial and commercial materials. NDT 
SetupBuilder is used to calculate phased array, ultrasound, and time-of-flight 
diffraction probe-element delays for Evident OmniScan instruments.

Software Compatibility

NDT SetupBuilder is compatible with OmniScan MX2 and OmniScan SX flaw 
detectors that run on MXU software version 3.2 or higher.

Instruction Manual

This instruction manual contains essential information on how to use this Evident 
product safely and effectively. Before using this product, thoroughly review this 
instruction manual. Use the product as instructed.
Important Information — Please Read Before Use
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Safety Symbols

The following safety symbols might appear on the instrument and in the instruction 
manual:

 General warning symbol
This symbol is used to alert the user to potential hazards. All safety messages that 
follow this symbol shall be obeyed to avoid possible harm or material damage.

 Shock hazard caution symbol
This symbol is used to alert the user to potential electric shock hazards. All safety 
messages that follow this symbol shall be obeyed to avoid possible harm.

Safety Signal Words

The following safety symbols might appear in the documentation of the instrument:

The DANGER signal word indicates an imminently hazardous situation. It calls 
attention to a procedure, practice, or the like, which, if not correctly performed or 
adhered to, will result in death or serious personal injury. Do not proceed beyond a 
DANGER signal word until the indicated conditions are fully understood and met.

The WARNING signal word indicates a potentially hazardous situation. It calls 
attention to a procedure, practice, or the like, which, if not correctly performed or 
adhered to, could result in death or serious personal injury. Do not proceed beyond a 
WARNING signal word until the indicated conditions are fully understood and met.

DANGER

WARNING
Important Information — Please Read Before Use
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The CAUTION signal word indicates a potentially hazardous situation. It calls 
attention to an operating procedure, practice, or the like, which, if not correctly 
performed or adhered to, may result in minor or moderate personal injury, material 
damage, particularly to the product, destruction of part or all of the product, or loss of 
data. Do not proceed beyond a CAUTION signal word until the indicated conditions 
are fully understood and met.

Note Signal Words

The following safety symbols could appear in the documentation of the instrument:

The IMPORTANT signal word calls attention to a note that provides important 
information, or information essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like, 
which requires special attention. A note also denotes related parenthetical 
information that is useful, but not imperative.

The TIP signal word calls attention to a type of note that helps you apply the 
techniques and procedures described in the manual to your specific needs, or 
provides hints on how to effectively use the capabilities of the product.

Warranty Information

Evident guarantees your Evident product to be free from defects in materials and 
workmanship for a specific period, and in accordance with conditions specified in the 
Terms and Conditions available at https://www.olympus-ims.com/en/terms/.

CAUTION

IMPORTANT

NOTE

TIP
Important Information — Please Read Before Use
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The Evident warranty only covers equipment that has been used in a proper manner, 
as described in this instruction manual, and that has not been subjected to excessive 
abuse, attempted unauthorized repair, or modification.

Inspect materials thoroughly on receipt for evidence of external or internal damage 
that might have occurred during shipment. Immediately notify the carrier making the 
delivery of any damage, because the carrier is normally liable for damage during 
shipment. Retain packing materials, waybills, and other shipping documentation 
needed in order to file a damage claim. After notifying the carrier, contact Evident for 
assistance with the damage claim and equipment replacement, if necessary.

This instruction manual explains the proper operation of your Evident product. The 
information contained herein is intended solely as a teaching aid, and shall not be 
used in any particular application without independent testing and/or verification by 
the operator or the supervisor. Such independent verification of procedures becomes 
increasingly important as the criticality of the application increases. For this reason, 
Evident makes no warranty, expressed or implied, that the techniques, examples, or 
procedures described herein are consistent with industry standards, nor that they 
meet the requirements of any particular application.

Evident reserves the right to modify any product without incurring the responsibility 
for modifying previously manufactured products.

Technical Support

Evident is firmly committed to providing the highest level of customer service and 
product support. If you experience any difficulties when using our product, or if it 
fails to operate as described in the documentation, first consult the user’s manual, and 
then, if you are still in need of assistance, contact our After-Sales Service. To locate the 
nearest service center, visit the Service Centers page on the Evident Scientific Web site.
Important Information — Please Read Before Use
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Introduction

NDT SetupBuilder software is complementary software for Evident automated 
ultrasonic testing (AUT) products. This software is designed to assist nondestructive 
testing (NDT) personnel by reducing the time required to define the appropriate 
inspection configuration for OmniScan instruments, ensuring that the configuration is 
compliant with the inspection code, and eliminating setup configuration errors.

NDT SetupBuilder software helps NDT supervisors define inspection techniques on a 
computer, enabling them to visualize how ultrasonic beams behave in the part to be 
inspected so that they can determine the appropriate number of beams and angles. 
This allows supervisors to define the inspection technique at the office or in the field, 
and more importantly, without the need for an actual inspection unit.

NDT SetupBuilder features a flexible graphical user interface that allows easy 
visualization of the inspected area, which helps make sure that it is 100 % covered by 
beams. Generic graphical features such as view-type selection, probe-set parameter 
adjustment (a few of the parameters are interactively adjustable), zoom tools, and 
measurement cursors are available.

NDT SetupBuilder runs on the Microsoft Windows 7 (32-bit and 64-bit), and 
Windows 8 operating systems.
Introduction
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1. Software Overview

NDT SetupBuilder software provides you with the ability to configure your 
inspection setups for OmniScan acquisition units without the need for any connected 
instrument.

1.1 NDT SetupBuilder Features

NDT SetupBuilder allows you to select the type of OmniScan acquisition unit for an 
inspection and define the part to be inspected. You can create weld overlays, 
configure the ultrasonic testing (UT) parameters, and define linear, sectorial, 
compound, or pitch-catch groups. (Pitch-catch groups are only available for time-of-
flight diffraction [TOFD] and dual matrix groups.) These groups are defined 
according to the chosen OmniScan instrument’s capabilities. The software can 
compute the attenuation, export to the acquisition software, and generate setup 
reports. Additionally, NDT SetupBuilder is able to calculate delays that cannot be 
calculated on the OmniScan instrument. NDT SetupBuilder can import .law files to 
enable inspections with configurations that exceed the OmniScan instrument’s built-
in capabilities.

NDT SetupBuilder software makes it easy to build inspection setups from scratch. The 
application helps you precisely program angle beams and focal points. Parameter 
entry is easy, because a large array of probe, wedge, and material data is 
preprogrammed into the database. Predefined part, probe, wedge, and group 
parameters can be modified to create custom parts, probes, and wedges. These 
options provide practically infinite possibilities when creating inspection setups.

In addition, the resulting groups and angle beams are displayed as a graphical 
representation, which is an important validation tool for inspection setups on 
OmniScan instruments.
Software Overview
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You can verify whether the theoretical configuration of probes and groups 
(respectively named probe sets and groups in NDT SetupBuilder) can be supported by 
your OmniScan acquisition units and models. To summarize, the software performs 
the following functions:

• Creates weld overlays
• Sets UT position parameters
• Defines linear, sector, compound, TOFD, and specific dual matrix groups
• For exported .law files, automatically computes focal laws, which are called beams 

in NDT SetupBuilder
• Generates setup reports
• Exports the inspection setups to the OmniScan acquisition software

For exported connectivity files, the entire setup configuration must be verified and 
computed after it has been imported into an OmniScan instrument.

The NDT SetupBuilder software’s graphical user interface provides a visual 
representation for the following adjustments:

• Part and weld overlay definition
• Probe sets definition: Build series of probe sets for ultrasonic testing (UT), phased 

array (PA), and time-of-flight diffraction (TOFD) inspection, and only display the 
ones that are needed.

• Probe and wedge definitions
• Group definitions: Create sector scan, linear scan, compound scan, or TOFD, and 

dual matrix pitch-catch inspection.
• UT parameter adjustments
• File export management
• Report generation

NOTE
Chapter 1
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1.2 File Transfer between NDT SetupBuilder and the OmniScan

Setup files can easily be transferred between NDT SetupBuilder and the OmniScan. 
The application can generate .ondtsetup connectivity files or .law delay files for 
export to OmniScan instruments. For more information, see “Supported File Formats” 
on page 27.

Connectivity files are a flexible option that can be used to transfer entire inspection 
setup configurations to the OmniScan. These configurations are then computed by the 
OmniScan prior to inspection and optimized according to the OmniScan model and 
the module being used. For more information, see “Exporting a Workspace As a 
Connectivity File” on page 162.

When delays cannot be computed natively by the OmniScan, .law files are an 
available option. Group setups computed in NDT SetupBuilder can be transferred to 
OmniScan instruments, where they are simply executed. To generate .law files, 
specific parameters must be configured. For more information, see “Exporting a 
Workspace as a .law File” on page 164.
Software Overview
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2. Installing the NDT SetupBuilder Software

Before you install the NDT SetupBuilder software on your computer, make sure the 
minimum requirements for installation are met. Installing NDT SetupBuilder is easy 
and straightforward.

2.1 Minimum Computer Requirements

The minimum requirements for the computer on which you want to install NDT 
SetupBuilder are:

• 2 GB RAM or higher
• 100 GB free hard disk space
• Graphics display card supporting 3-D computer-aided design (CAD) and 

DirectX 9.0
• 1280 × 1024 pixels or higher display adaptor and monitor resolution
• One USB port for the HASP security hardware key
• A keyboard
• A pointing device. A mouse with three buttons is highly recommended to 

manipulate the RayTracing view.
• One of the following operating systems:

— Microsoft Windows 7, 32-bit and 64-bit versions
— Microsoft Windows 8
Installing the NDT SetupBuilder Software
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NDT SetupBuilder can be installed on a drive other than that on which Windows 
resides. In such case, the NDT SetupBuilder installer will still require 150 MB on the 
drive where Windows resides in order to install the hardware security key driver, 
DirectX updates, and Windows temporary installation.

In this document, NDT SetupBuilder screenshots were taken on a computer running 
Windows 7. The appearance of the screenshots may differ if you are using NDT 
SetupBuilder on a computer running Windows 8.

For most examples in this document, NDT SetupBuilder was arbitrarily configured to 
use the metric measurement units (see “Changing the Measurement Unit Parameters” 
on page 25 for information about how to change measurement units).

2.2 Installing NDT SetupBuilder

Installing NDT SetupBuilder is simple and is done with a standard software installer.

To install NDT SetupBuilder

1. Log on to the computer on which you want to install NDT SetupBuilder using a 
user account with administrator rights.

2. Access the installer for the NDT SetupBuilder software on the Evident website at 
EvidentScientific.com. The component can also be found on the USB flash drive 
provided with Evident instruments.

The Evident website contains the most recent version of the NDT SetupBuilder 
installer.

3. Double-click InstallSetupBuilder-[VersionNumber].exe.

IMPORTANT

NOTE

NOTE
Chapter 2
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The installation wizard appears.
4. Follow the steps in the NDT SetupBuilder installer wizard that appears on the 

screen.
Installing the NDT SetupBuilder Software
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3. Getting Started with NDT SetupBuilder

After NDT SetupBuilder has been installed, you can access the software by inserting 
the provided HASP security hardware key into one of your computer’s USB ports.

NDT SetupBuilder has been designed as a simple and easy-to-use tool used to 
configure inspection setups.

Three menus (File, Tools, and Help) contain all of the commands that provide access 
to the main application, file, part, weld, acquisition unit, probe, wedge, element 
deactivation or activation, and report management features.

Two tabs (Probe Sets and Groups) contain toolbars with controls that can be used to 
manage the probe sets and groups, in addition to parameters that can be used to 
configure inspection setups.

The RayTracing view displays a graphical representation of the part, weld, probe sets, 
and groups used to define your inspection setups. A toolbar provides interactive 
controls to change the view and modify certain probe-set parameters.

3.1 Starting NDT SetupBuilder

With NDT SetupBuilder, you configure inspection setups without a connected 
OmniScan instrument. After your inspection setups have been completed, the saved 
inspection setup files can be transferred to an OmniScan using a storage device such 
as a USB key or an SD card.

To start NDT SetupBuilder, use the usual commands provided under the Windows 
operating system.
Getting Started with NDT SetupBuilder
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To start NDT SetupBuilder

1. Connect the HASP security hardware key to the appropriate USB port of the 
computer. NDT SetupBuilder must be able to detect the security hardware key in 
order to operate.

2. Turn on the computer and wait for Windows to complete its start-up process. Do 
not start NDT SetupBuilder until this process has completed.

3. Start NDT SetupBuilder:

 On the Windows desktop, double-click the NDT SetupBuilder icon .
OR

On the Windows taskbar, select Start > All Programs > Evident NDT > NDT 
SetupBuilder n.n > NDT SetupBuilder n.n.

3.2 Exiting NDT SetupBuilder

To exit NDT SetupBuilder, use the standard commands available under the Windows 
operating system.

To exit NDT SetupBuilder

 On the File menu, select Exit.
OR
Click the Close button located on the right-hand side of the main window’s title 
bar (see Figure 3-1 on page 24).

Figure 3-1  The Close button on the title bar

Close button
Chapter 3
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3.3 Workspace

Starting the NDT SetupBuilder software opens a workspace. A workspace is actually 
an inspection setup file. It contains all the parameters of an inspection setup: 
acquisition unit, part, weld (if appropriate), probe set, and group.

By default on start-up, NDT SetupBuilder opens a new untitled workspace with 
default parameters. An existing workspace with configured parameters can also be 
opened and edited using menu commands, management dialog boxes, and toolbars 
and parameters on tabs.

3.4 Changing the Measurement Unit Parameters

The NDT SetupBuilder preferences can be used to change the measurement unit for 
your inspection setup.

The following two measurement units are available: metric (millimeters) and imperial 
(inches).

The metric measurement units, values, precision, and increments are displayed in 
Table 1 on page 25.

The imperial measurement units, values, precision, and increments are displayed in 
Table 2 on page 26.

Table 1  Metric measurement units 

Measurement 
type

Measurement 
unit Symbol Precisiona

a. In the Manage Probes and Manage Wedges dialog boxes, several of the parameter val-
ues are displayed with a three-digit precision.

Increment

Velocity Meters per 
second

m/s No digit 1

Distance Millimeters mm One digit 1
Frequency Megahertz MHz Two digits 0.25
Angles Degrees ° One digit 1.0
Others — — One digit 1
Getting Started with NDT SetupBuilder
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To change the measurement unit

1. On the Tools menu, select Preferences.
2. In the Preferences dialog box, click the Units list, and then select the appropriate 

measurement unit (see Figure 3-2 on page 26).

Figure 3-2  Selecting the measurement unit in the Preferences dialog box

There are two measurement units to choose from: Millimeters and Inches. The 
default measurement unit is Millimeters.

3. Click Save.
The selected measurement unit is immediately updated in all the NDT 
SetupBuilder interfaces, and in the newly generated reports.

In the Manage Wedges dialog box, point the mouse to each parameter to display a 
tooltip with a short description.

Table 2  Imperial measurement units 

Measurement 
type

Measurement 
unit Symbol Precision Increment

Velocity Inches per 
microsecond

in./µs Four digits 0.04

Distance Inches in. Four digits 0.04
Frequency Megahertz MHz Two digits 0.25
Angles Degrees ° One digit 1.0
Others — — Four digits 1

NOTE
Chapter 3
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3.5 Supported File Formats

NDT SetupBuilder, allows you to configure entire inspection setup parameters and 
then generate .ondtsetup or .law files, which can then be exported to OmniScan 
instruments.

Setup files can be easily transferred from NDT SetupBuilder to an OmniScan.

NDT SetupBuilder can export beam (focal law) configurations to the OmniScan using 
the .law file format described in Table 3 on page 27.

All the groups created using NDT SetupBuilder can be exported as .law files. To 
generate .law files, the following parameters need to be configured:

• Focal laws for long seam inspection
• Dual matrix array inspection

Table 3  File format supported by NDT SetupBuilder 

File type Extension File content
Evident 
connectivity

.ondtsetup All the parameters needed to recreate the setup.
The parameters are computed on the OmniScan 
instrument, with the results optimized in 
accordance with the model and module used for 
inspection (see “Exporting a Workspace As a 
Connectivity File” on page 162).

OmniScan setup .law Calculated ultrasonic group parameters readable 
by the OmniScan and other equipment.
The parameters are computed by NDT 
SetupBuilder, and the inspection is executed on the 
OmniScan instrument without additional 
calculations. This makes it possible to calculate 
delays that could not be obtained natively by the 
OmniScan instrument and then perform 
inspections that exceed the unit’s built-in 
capabilities (see “Exporting a Workspace as a .law 
File” on page 164).
See “Description of the .law File Format” on 
page 179 for more information.
Getting Started with NDT SetupBuilder
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• Linear lateral inspection
• Compound scan

For more information on exporting inspection setups, see “Exporting Setup Files to an 
OmniScan Instrument” on page 161.
Chapter 3
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4. Interface Overview

The NDT SetupBuilder user interface includes a menu bar, two tabs along the top 
portion, and a RayTracing view in the lower portion (see Figure 4-1 on page 29).

Figure 4-1  The NDT SetupBuilder user interface

The menu bar is simple. It provides file-related, tool-related commands (acquisition 
unit, part, probe manager, wedge manager, preferences, and probe-element 
deactivation) in addition to help-related commands.

Menu bar

Groups tab

Probe Sets tab

RayTracing
view

Measurement
and reference

cursors

RayTracing
view toolbar

RayTracing
view axes

Split bar

Tooltip example
Interface Overview
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The two tabs provide toolbars and parameters to define probes and groups for the 
inspection setups. In each tab, the probe sets (see “Probe Sets Tab” on page 32) or the 
groups (see “Groups Tab” on page 32) of the inspection setup are displayed as lists 
from which parameters can be configured.

The RayTracing view located in the lower portion of the main interface (see 
“RayTracing View” on page 40) displays a graphically rendered 2-D or 3-D 
illustration of the part, probes, wedges, in addition to display options, interactive 
parameter configuration controls, and probe-element information.

Between the tabs area and the RayTracing view, a split bar allows you to change the 
relative surface occupied by the tabs and the RayTracing view (see “Modifying the 
Pane Size in the Main Window” on page 54).

Explanatory tooltips are displayed by pointing the mouse over almost all of the 
interface elements, including the tabs, toolbars, and dialog boxes (see “RayTracing 
View” on page 40). The only exceptions are the File, Tools, and Help menus and 
commands and the contents displayed in RayTracing view.

From the NDT SetupBuilder interface, you can refer to an online help version of this 
user’s manual. For more information, see “Accessing the Online Help” on page 55.

4.1 Menus

The NDT SetupBuilder menu bar provides three menus: File, Tools, and Help.

The File menu contains commands for operations related to managing workspaces, 
exporting setups to various file formats, and exiting NDT SetupBuilder.

The Tools menu contains commands for operations related to selecting the acquisition 
instrument, defining the part and weld for the inspection setup, managing probes and 
wedges, configuring NDT SetupBuilder preferences, and deactivating or reactivating 
phased array probe elements.

The Help menu contains commands for operations related to managing the NDT 
SetupBuilder software.
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4.2 Accessing Commands Using Keyboard Shortcuts

Several of the menu commands available in the File, Tools, and Help menus can be 
activated using keyboard shortcuts. Keyboard command shortcuts are found in the 
menus on the right-hand side of the corresponding command (see Figure 4-2 on 
page 31 and Table 4 on page 31).

Figure 4-2  Menu commands and keyboard shortcuts

On the Probe Sets tab, Groups tab, and in the RayTracing view, several commands 
from the toolbars or parameters can also be activated using keyboard shortcuts (see 
Table 4 on page 31).

Table 4  Menu commands with keyboard shortcuts 

File menu Tools menu Help menu
Command Shortcut Command Shortcut Command Shortcut

New CTRL+N Acquisition Unit F5 Help F1
Open CTRL+O Part F6
Save CTRL+S Probes F7
Save As SHIFT+CTRL

+S
Wedges F8

Generate 
Report

CTRL+R Preferences CTRL + 
Comma

Exit ALT+F4

Keyboard shortcuts
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4.3 Probe Sets Tab

The Probe Sets tab contains the functions and parameters needed to configure the 
probes, probes, wedges, and hardware connections for the inspection setup. For more 
details, see “Configuring One or More Probe Sets” on page 91.

4.4 Groups Tab

The Groups tab contains functions and parameters needed to configure the groups 
for the inspection setup. For more details, see “Configuring One or More Groups” on 
page 137.

4.5 Identifying Selected Probe Sets in RayTracing View

When you select one or more probe sets in the Probe Sets tab, or when you select one 
or more of their associated groups in the Groups tab, the probe sets become 
highlighted in green in RayTracing view (see Figure 4-3 on page 33).

Table 5  Tab and RayTracing view commands with keyboard shortcuts 

Probe Sets tab Groups tab RayTracing view
Command Shortcut Command Shortcut Command Shortcut

Add Probe CTRL+Insert Add Group CTRL+Insert Show Top (C) 
View

CTRL+1

Delete Probe CTRL+Delete Delete Group CTRL+Delete Show Side (B) 
View

CTRL+2

Duplicate 
Probe

CTRL+D Duplicate 
Group

CTRL+D Show End (D) 
View

CTRL+3

Visible Probe CTRL+H Visible 
Group

CTRL+H Show 3-D View CTRL+4
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Figure 4-3  The selected probe set highlighted in green in RayTracing view

4.6 Customizing the Display of the Probe Sets Tab or Groups Tab Data

The default column configuration and the data display from the Probe Sets and 
Groups tabs can be customized according to your needs. This allows you to relocate, 
hide, or display columns as well as sort, group, or filter alphanumeric data to reorder 
rows.

The section headers on the Probe Sets and Groups tabs do not contain the shortcut 
menu with the column-configuration and data display commands.

4.6.1 Relocating Columns or Sections on a Tab

On the Probe Sets or Groups tab, section columns or column headers can be easily 
relocated using a drag-and-drop operation (see Figure 4-4 on page 34).

A probe set selected in
the tab is highlighted in

green.
Selecting one or more

groups associated with
the probe set also

highlights the probe set.

NOTE
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Figure 4-4  Dragging a column header on a tab

To relocate a column or a section header on a tab

 Drag the column header or section header to the desired location on the same tab.

On the Probe Sets or Groups tab, when a section header (the column in the top row) 
is dragged, the columns below it are also relocated (see Figure 4-5 on page 34).

For example, when you drag the Probe section header on the Probe Sets tab, the 
Series and Model columns of that section are also simultaneously relocated.

Figure 4-5  Dragging a section header on a tab

4.6.2 Sorting Data in a Column

The data in the Name column of the Probe Sets tab and in the Probe column of the 
Groups tab can be assorted in ascending or descending order. The availability of the 
sort function is indicated by an arrow on the column header (see Figure 4-6 on 
page 35).
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Figure 4-6  The Sort toggle indicator

The items in the tab are sorted in ascending order when the arrow on the column 
header is pointing upward and in descending order when the arrow is pointing 
downward.

To sort data within a column

 Click the Name or the Probe column header to sort the data in ascending or 
descending order, as indicated by the arrow on the column header.
The sort function is a toggle command.

4.6.3 Removing and Inserting Columns or Sections on a Tab

On the Probe Sets or Groups tabs, columns, column headers, and sections can be 
removed or reinstated.

To remove or insert a column or a section header on a tab

 Right-click the column header on the Probe Sets or Groups tab, and then, on the 
shortcut menu, select one of the following commands (see Figure 4-7 on page 36):

The Sort toggle
indicator in the
Name column

of the Probe
Sets tab and in

the Probe
column of the

Groups tab
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Figure 4-7  Removing a column from a tab

— Remove This Column
The column disappears from the tab.

— Column Chooser
The Customization dialog box appears (see Figure 4-8 on page 37), in which 
one of the following operations can be performed:
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Figure 4-8  Returning a column on a tab

○ To remove a column, drag the desired column header of the tab to the 
Columns tab of the Customization dialog box.

○ To replace a previously removed column on the tab, drag the desired 
column header from the Columns tab in the Customization dialog box 
back to the tab, or double-click the column header. When you double-
click a column header, it returns to its original position before being 
removed.

○ To remove an entire section header, including all of its columns, drag the 
desired section header from the tab on the main window to the Bands tab 
in the Customization dialog box (see Figure 4-9 on page 38).
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Figure 4-9  Removing a section header from a tab

○ To return a section header removed from the tab, drag the desired section 
header from the Bands tab in the Customization dialog box back to the 
tab, or double-click the column header. When you double-click a column 
header, it returns to its original position before being removed.

On the Probe Sets and Groups tabs, the section headers do not contain the shortcut 
menu with the column-configuration and data display commands.

4.6.4 Adjusting the Columns using the Best-Fit Function

The Probe Sets or Groups tab can be used to best-fit the width of individual columns. 
In other words, this enables you to select the best column width for data display.

NOTE
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To best-fit columns on a tab

 Right-click a column header on Probe Sets or Groups tab, and then, on the 
shortcut menu, click Best-Fit (see Figure 4-10 on page 39).

Figure 4-10  Best-fitting the data within a column on a tab

The column width is adjusted to the length of the line with the most content.

The section headers on the Probe Sets and Groups tabs do not contain the shortcut 
menu with the column-configuration and data display commands.

NOTE
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4.7 RayTracing View

NDT SetupBuilder contains a RayTracing view that is similar to those offered in other 
Evident software. The RayTracing view displays graphical representations of the part 
and the weld, predefined or custom probe sets (probes and wedges), and the groups 
that are used in the inspection setups.

The RayTracing view provides standard Side (B-scan), Top (C-scan), and End (D-scan) 
data views with color-coded axes and an interactive 3-D view.

Table 6 on page 40 lists the basic ultrasonic views (scans) that are illustrated in 
Figure 4-11 on page 41. The color-coded axis content for each viewing option 
provided in RayTracing view is illustrated in Figure 4-12 on page 42.

Table 6  Basic data views available in RayTracing view

 Point of view View Axis content
Top C-scan Scan (blue) versus Index (green)
Side B-scan Ultrasound (pink) versus Scan (blue)
End D-scan Ultrasound (pink) versus Index (green)
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Figure 4-11  Top, Side, and End ultrasonic views with 90° probe skew angle

In the example in Figure 4-11 on page 41, if the probe skew angle is 0° (or 180°), the 
Side view becomes the End view, and vice versa.
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Figure 4-12  Axis content for the RayTracing view options

The RayTracing view provides the following controls and elements, which are used to 
view and configure inspection setups:

End (D) view (default) Top (C) view

Side (B) view

3-D view
No axes are displayed.

Ultrasound axis (pink)

Index axis (green)

Scan axis (blue)
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Toolbar

Figure 4-13  The toolbar for the RayTracing view

The RayTracing view toolbar is located in the upper-left corner. This view 
provides controls for adjusting the view according to your needs and for 
interactive modification of three probe parameters (see Figure 4-13 on page 43).

The toolbar controls can be used to perform the following tasks in RayTracing 
view:

— Select a view type (see “Selecting a View Type” on page 45).
— Interactively modify probe parameter values (see “Interactively Modifying 

Probe Parameter Values” on page 47).
— Zoom the RayTracing view (see “Zooming the RayTracing View” on page 50).

On the RayTracing view toolbar, point the mouse to each toolbar element to display a 
tooltip with a short description of the function.

Rulers
The rulers are scales displayed on the left and at the bottom of the RayTracing 
view (see Figure 4-14 on page 44). The color of the ruler identifies the axis. For 
more information about the axis color codes, see “RayTracing View” on page 40.

View-type 
selection 
buttons

Probe-set scan offset, probe-set index offset, and probe 
center separation (PCS) parameter sliders

View InfoZoom buttons

NOTE
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Figure 4-14  RayTracing view axis components

Zoom bars
Zoom bars appear on the left and bottom edges of the RayTracing view (see 
Figure 4-14 on page 44). Each zoom bar contains a zoom box that enables you to 
set the visible part of the view. The zoom box shows the relative position and 
proportion of the graphical representation currently visible in the display area 
relative to the contents of the entire RayTracing view. The color of the zoom bar 
identifies the axis on the different views.

To zoom in or out of the RayTracing view using a zoom bar, drag one end of the 
zoom bar to resize it. Scroll through the zoom bar to view other parts of the 
graphical representation (see “Zooming the RayTracing View” on page 50).

To reset a zoom bar, just double-click it.

Cursors
The cursors are thin horizontal and vertical lines used to identify points and/or a 
region within RayTracing view. Two cursor types are available: reference and 
measurement cursors. A pair of each type of cursor is displayed: one vertically 
and the other horizontally. Reference cursors are red and measurement cursors 
are blue. A label indicates the exact coordinate of each cursor along the x-axis or 
y-axis.

Reference and measurement cursors can be displayed quickly in RayTracing view 
(see “Displaying Cursors” on page 53).
In other Evident software, the cursors are also used to measure the data 
displayed.

Zoom bars RulerZoom bar end used to zoom the RayTracing view

Ruler

TIP
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In RayTracing view, the configured part, weld, probe sets (probes and wedges), 
groups, and group focus points are displayed at their true scale (see Figure 4-15 on 
page 45). The first element of a probe is identified with a red outline. Group focus 
points are displayed as green dots.

Figure 4-15  Part, weld, probe set, and group representation in RayTracing view

4.8 Selecting a View Type

The RayTracing view toolbar provides the following controls, which are used to 
select a point of view:

For dual matrix-type probes, the End (D) view is selected by default. The Top (C) 
view, Side (B) view, and 3-D view are not available.

— Show Top (C) View ( )

Wedge damping

Part (plate)

First element of probe
(outlined in red)

Probe

Group Beam focus points 
(green dots)

Wedge

Weld
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The Top (C) view is defined by the index axis (represented by the vertical axis 
in RayTracing view), and the scan axis (represented by the horizontal axis). 
The Top (C) view provides a C-scan view (see Figure 4-16 on page 46).

Figure 4-16  Top (C-scan) view

— Show Side (B) View ( )
The Side (B) view is defined by the ultrasound axis (represented by the 
vertical axis in RayTracing view) and the scan axis (represented by the 
horizontal axis). The Side (B) view provides a B-scan view (see Figure 4-17 on 
page 46).

Figure 4-17  Side (B-scan) view

— Show End (D) View ( )
The End (D) view is defined by the ultrasound axis (represented by the 
vertical axis in RayTracing view) and the index axis (represented by the 
horizontal axis). The End (D) view provides a D-scan view (see Figure 4-18 on 
page 47).
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Figure 4-18  End (D-scan) view

— Show 3-D View ( )
The 3-D view provides a three-dimensional view of the setup defined by the 
ultrasound axis, the scan axis, and the index axis.

For complete descriptions of these points of view, see “RayTracing View” on page 40.

To select a view type

 Click the appropriate point-of-view button on the RayTracing view toolbar: Show 
Top (C) View, Show Side (B) View, Show End (D) View, or Show 3-D View.

The RayTracing view toolbar’s points-of view commands can be activated using 
keyboard shortcuts. For more information, see “Accessing Commands Using 
Keyboard Shortcuts” on page 31.

4.9 Interactively Modifying Probe Parameter Values

The RayTracing view toolbar provides the following controls, which can be used to 
interactively modify the parameters of a probe set selected on the Probe Sets tab:

• Probe-Set Scan Offset slider 
The Probe-Set Scan Offset slider changes the distance between the center of the 
probe front and the origin (zero) of the scan axis.

TIP
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The parameter value for the selected probe set is interactively updated in the 

Probe-Set Scan Offset ( ) column of the Probe Sets tab (see “Configuring 
Probe-Set Position Parameters” on page 130).

• Probe-Set Index Offset slider 
The Probe-Set Index Offset slider changes the distance between the center of the 
probe front and the origin (zero) of the index axis.

The parameter value for the selected probe set is interactively updated in the 

Probe-Set Index Offset ( ) column of the Probe Sets tab (see “Configuring 
Probe-Set Position Parameters” on page 130).

• Probe Center Separation (PCS) slider 
The PCS slider changes the distance between a pair of probes, the probe center 
separation (PCS) distance from exit point to exit point, or the distance for a TOFD-
type probe set.

On the Probe Sets tab for the selected probe set, the parameter value is 

interactively updated in the Probe Center Separation (PCS) ( ) column 
(see “Configuring Probe-Set Position Parameters” on page 130).

The Probe Center Separation (PCS) slider is unavailable for a probe set of the PA 
linear, UT, or dual matrix type.

To interactively modify one of the three probe-set parameters using the RayTracing view 
toolbar

1. Select a probe set on the Probe Sets tab, or select a group in the Groups tab (the 
parameters of the probe set related to this group will be modified).

2. Move the Scan Offset, Index Offset, or Probe Center Separation (PCS) slider to 
the left to reduce the parameter value, or move the slider to the right to increase it.
The value is automatically updated in the corresponding column on the Probe 
Sets tab, and the graphical representation is automatically and accurately 
updated in RayTracing view.

NOTE
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4.10 Viewing Inspection Setup Information

The RayTracing view toolbar contains a Setup Info button, which can be used to view 
specific information.

To view inspection setup information

 Click the Setup Info button on the right-hand side of the RayTracing view toolbar 
(see Figure 4-19 on page 49).

Figure 4-19  Clicking the Setup Info button on the RayTracing view toolbar

The Setup Info pane opens on the right-hand side of the RayTracing view. It 
displays information related to the items selected in the active tab, the visibility of 
probe sets and groups, and the part parameters (see Figure 4-20 on page 50).
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Figure 4-20  The RayTracing view with the Setup Info pane displayed

4.11 Zooming the RayTracing View

To change the zoom factor or the appearance of the RayTracing view, use the toolbar’s 
zoom buttons, the mouse, or the zoom bars.

The RayTracing view toolbar contains the following controls, which can be used to 
zoom in and out:

— Zoom In button ( )

— Zoom Out button ( )

— Reset Zoom button ( )

— Custom Zoom button ( )
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When using the Zoom In button ( ), the RayTracing view is zoomed in at 200 %. 

When using the Zoom Out button ( ), the RayTracing view is zoomed out at 50 % of 
the current scale, and always from its center point. The graphical representation is 
scaled proportionally.

The 100 % scale in RayTracing view shows the entire part and all the probe sets 
included in your inspection setup.

To zoom in on the RayTracing view

 Click the Zoom In button ( ) on the toolbar.
The graphical representation is scaled proportionally to 200 % of the initial view.
OR

In the box on the right-hand side of the Custom Zoom button ( ) on the 
toolbar, type a value higher than 100 %, and then click the Custom Zoom 

button ( ).
The graphical representation is scaled proportionally.
OR
In 2-D view (for Top [C], Side [B], or End [D] view, see “Selecting a View Type” on 
page 45), drag the mouse vertically, horizontally, or diagonally on the graphical 
representation in RayTracing view to define the zone of interest.
When you release the mouse button, the RayTracing view zooms in on the 
selected area.

When zooming the RayTracing view with a mouse drag, the graphical representation 
is not scaled proportionally. Use one of the toolbar’s zoom buttons to reset the scale 
factor to 1:1 in RayTracing view.

NOTE

NOTE
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To zoom out of RayTracing view

 Click the Zoom Out button ( ) on the RayTracing view toolbar.
The graphical representation is scaled proportionally to 50 % of the initial view.
OR

In the box on the right-hand side of the Custom Zoom button ( ) on the 
toolbar, type a value equal to or higher than 100 %, and then click the Custom 

Zoom button ( ).
The graphical representation is scaled proportionally.

To reset the RayTracing view to 100 % scale

 Click the Reset Zoom button ( ) on the RayTracing view toolbar.
The graphical representation is scaled proportionally to 100 %.
OR

In the box on the right-hand side of the Custom Zoom button ( ) on the 

toolbar, type the 100 % value, and then click the Custom Zoom button ( ).
The graphical representation is scaled proportionally to 100 %.

To zoom in on or change the appearance of the graphical representation in 3-D view

 Drag one of the three mouse buttons on the graphical representation in 
RayTracing view to move it in 3-D space:
— Left mouse button: Rotate the 3-D graphical representation along the x, y, and z 

axes.
— Middle mouse button: Zoom in or out of the 3-D graphical representation.
— Right mouse button: Move the 3-D graphical representation up, down, left, or 

right without rotating it.

To zoom the RayTracing view using the zoom bars

 Drag one end of an axis’ zoom bar to interactively change the zoom factor of the 
RayTracing view along that axis (see Figure 4-21 on page 53).
OR
Enter values as follows:
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a) Hold down the CTRL key and click a zoom bar to display the zoom bar 
parameter box.

b) Enter values in the Start and Stop boxes.
c) Press Return.

Figure 4-21  Zoom bar controls in RayTracing view

To reset the scale ratio to 1:1 in RayTracing view

 Double-click an axis zoom bar to reset the scale ratio of the RayTracing view to 1:1 
along that axis (see Figure 4-21 on page 53).
OR

Click one of the zoom buttons ( , , , or ) on the RayTracing view 
toolbar to reset the scale ratio of the RayTracing view to 1:1 along both axes.

4.12 Displaying Cursors

Both the reference and measurement cursors can be quickly displayed in 
RayTracing view (see Figure 4-22 on page 54).

Zoom bar axis ends
Zoom bar parameters box
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Figure 4-22  Reference and measurement cursors in RayTracing view

To display the reference cursors

 Double-click the RayTracing view.

To display the measurement cursors

 Double right-click the RayTracing view.

4.13 Modifying the Pane Size in the Main Window

The split bar in between the tabs area and the RayTracing view can be used to change 
the relative surface area of the tabs and the RayTracing view (see Figure 4-23 on 
page 55).

Vertical and horizontal 
reference cursors

Vertical and horizontal
measurement cursors
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Figure 4-23  Using the split bar to modify the size of the main window’s panes

To modify the pane size in the main window

 Drag the split bar up or down in between the tabs area and the RayTracing view.

4.14 Accessing the Online Help

The contents of the NDT SetupBuilder User’s Manual are available as an interactive 
HTML help file directly within the software.

To access the online help

 On the Help menu, click Online Help.
The NDT SetupBuilder HTML help window appears (see Figure 4-24 on page 56).

Split bar cursor

Split bar
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Figure 4-24  The HTML help window

Use the Contents, Index, Search, and Favorites tab tools to find relevant information.

4.15 NDT SetupBuilder Software

The About NDT SetupBuilder window contains the NDT SetupBuilder version 
number and copyright information.

To access the About NDT SetupBuilder window

 On the Help menu, click About.
The About NDT SetupBuilder window appears (see Figure 4-25 on page 56).

Figure 4-25  The About NDT SetupBuilder window
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5. Designing and Configuring Inspection Setups

When defining an inspection setup or technique, a workspace must first be created or 
opened before configuring or modifying the inspection parameters.

The general procedure to create inspection setups consists of managing workspaces, 
selecting acquisition units, configuring the parts and welds to be inspected (as well as 
the probe sets and groups that are to be used for the inspection), exporting the setups 
to an instrument, and generating reports.

To design and configure an inspection setup

1. Create a new workspace, or open an existing one.
For more information, see “Managing Inspection Setup Files” on page 59.

2. Select an acquisition unit.
For more information, see “Selecting an Acquisition Unit” on page 65.

3. Configure the part to be inspected.
For more information, see “Managing Inspection Setup Files” on page 59.

4. Configure one or more probe sets.
For more information, see “Configuring One or More Probe Sets” on page 91.

5. Configure one or more groups.
For more information, see “Configuring One or More Groups” on page 137.

6. Export the inspection setup to a file.
For more information, see “Exporting Setup Files to an OmniScan Instrument” on 
page 161.

7. Generate a report on the inspection setup.
For more information, see “Generating Reports” on page 169.
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6. Managing Inspection Setup Files

One inspection setup can be saved per setup file. A setup file must be created for each 
weld inspection technique requiring configuration. Each setup file contains a 
workspace with a defined part and weld, and one or more required probes, wedges, 
and groups.

If managing multiple inspection projects, you will need to create and use several 
setup files. Each type of inspection technique requires one setup file, each with its 
own workspace.

Afterwards, the setup files containing the inspection setups will be available for 
transfer to the OmniScan inspection instruments. These setup files can also be used as 
the basis for creating other inspection setups.

6.1 Creating a Workspace

By default, a new workspace is created when you open NDT SetupBuilder. That 
workspace is used to design and configure a weld inspection technique. Workspace 
files have the .wkb extension.

Upon creation, the workspace contains a mild steel plate part with a symmetrical V 
weld. In place of a plate part, a tube part or bar part can be selected. Defining a weld is 
optional. The part and weld are fully configurable. Probes, wedges, and groups can 
also be selected or created, and then configured. For more information about 
designing and configuring a weld inspection technique, see “Designing and 
Configuring Inspection Setups” on page 57.

After you have completed work on an inspection setup, the workspace can be saved 
to a setup file. A new workspace can then be created in order to configure another 
setup.
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To create a new workspace

 Start NDT SetupBuilder. A new workspace with a default part and weld is 
automatically created. For more in formation, see “Starting NDT SetupBuilder” 
on page 23.
OR
On the File menu, click New.
A new workspace is created. If a workspace was already opened in NDT 
SetupBuilder, you have the option to save it before it is closed.

6.2 Opening a Workspace

It is possible to open a previously saved and closed workspace.

To open a workspace

1. On the File menu, click Open.
2. In the Open dialog box, select the desired workspace file (see Figure 6-1 on 

page 60).

Figure 6-1  The Open dialog box used to open a workspace

3. Click Open.
The selected workspace file is displayed.
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The workspace can then be edited and saved (see “Saving a Workspace” on page 61), 
or it can be saved under a new name to serve as the basis for a new inspection 
technique (see “Saving a Workspace as a New File” on page 62).

6.3 Saving a Workspace

After creating or opening a workspace, the Save command in the File menu is 
unavailable. After you have changed at least one parameter in the workspace, the 
Save command becomes available.

When a change is made to an open workspace, an asterisk is displayed after the name 
of the file in the title bar until the change has been saved (see Figure 6-2 on page 61).

Figure 6-2  Title bar with an asterisk to indicate unsaved changes

To save a workspace

1. On the File menu, click Save.
2. In the Save As dialog box, choose the folder where you want to save the 

workspace file (see Figure 6-3 on page 62).

Asterisk displayed in title bar after the workspace name
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Figure 6-3  The Save As dialog box used to save a workspace

3. In the File name box, enter the name for the file.
4. Click Save.

The workspace file is saved with the .wkb extension.

6.4 Saving a Workspace as a New File

A workspace can be saved as a new file that can be used as the basis for a new 
inspection setup.

To save a workspace as a new file

1. On the File menu, click Save As.
2. In the Save As dialog box, select the folder where you want to save the workspace 

file (see Figure 6-4 on page 63).
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Figure 6-4  The Save As dialog box used to save a workspace as a new file

3. In the File name box, enter a name for the file.
4. Click Save As.
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7. Selecting an Acquisition Unit

For every inspection setup configured in NDT SetupBuilder, you must select the 
target acquisition unit technology. By default, the OMNI-PA acquisition unit 
technology is selected, because it is the most commonly used.

Because the choice of target acquisition unit technology has an effect on all aspects of 
your inspection setup, selecting the acquisition unit technology should always be the 
first step of the configuration procedure.

The values that depend on the target acquisition unit technology are element quantity 
(aperture), UT channel (pulser and receiver, found on the Probe Sets tab, if they are 
available for a unit or module), and first and last element (found on the Groups tab).

The OMNI-PA and OMNI-UT instrument options allow full configuration and 
support of OmniScan instruments, and enable saving inspections setups in the 
connectivity file format (.ondtsetup) or .law file format, for importing into the 
instruments for processing and for performing inspections.

The Generic PA and Generic UT instrument options allow generic configuration of 
inspections setups, which can be saved as .law files only.

To select an acquisition unit

1. On the Tools menu, click Acquisition Unit.
2. In the Acquisition Unit dialog box (see Figure 7-1 on page 66), in the Instrument 

list, select the target acquisition unit technology for which you want to create 
groups:
— OMNI-PA: Phased array OmniScan for multi-element probe set.
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By default, the OMNI-PA OmniScan target technology is selected. The 
OMNI-PA option offers support for PA linear, TOFD, and UT probe-set 
types. By default, 16 active elements and 128 total elements are selected.

— OMNI-UT: OmniScan for single element probe set.
— Generic-PA: Generic phased array instrument for multi-element probe set.
— Generic-UT: Generic instrument for single element probe set.

Figure 7-1  The Acquisition Unit dialog box

When the OMNI-PA or Generic-PA option is selected, the None option is 
available in the UT channels list, which enables you to select no channels for the 
inspection setup.
When the OMNI-UT or Generic-UT option is selected, the Active elements and 
Total elements lists become unavailable, because the UT target technology 
supports single-element probe sets only (see Figure 7-1 on page 66).

Figure 7-2  The Acquisition Unit dialog box with UT target technology
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When the Generic-PA or Generic-UT option is selected, more options are 
displayed in the other lists available in the Acquisition Unit dialog box (see 
Figure 7-3 on page 67).

Figure 7-3  The Acquisition Unit dialog box with the various list options

3. In the Module list, select the module unit (see Figure 7-4 on page 68).

OMNI-PA 
instrument 
selected

Generic-PA 
instrument 
selected

OMNI-UT 
instrument 
selected

Generic-UT 
instrument 
selected
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Figure 7-4  The Acquisition Unit dialog box

4. In the Active elements list, select the number of active elements on the probe.
The default value is 16 elements. The number of active elements that is selected 
defines the maximum element quantity (aperture) for the groups.
When the number of active elements selected in the Active elements list is not 
supported by the selected instrument technology, the value in the Active 
elements list is automatically adjusted based on the module’s capacity.

5. In the Total elements list, select the total number of elements on the probe.
The default value is 128 elements.
When the number of total elements selected in the Total elements list is smaller 
than the number of active elements selected in the Active elements list, the value 
in the Total elements list is automatically adjusted based on the module’s 
capacity.
When the number of total elements selected in the Total elements list does not 
correspond with the number of total elements supported by the selected 
instrument technology, the value in the Total elements list is automatically 
adjusted based on the module’s capacity.

6. In the UT channels list, select the number of channels for the inspection setup.
The default value is 1 channel.
When the number of channels selected in the UT channels list does not 
correspond with the number of channels supported by the selected instrument 
technology, the value in the UT channels list is automatically adjusted based on 
the module’s capacity.
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 The number of channels selected when defining the acquisition unit technology 
become available in the Pulser and Receiver column lists from the Hardware 
Connection section on the Probe Sets tab, when a probe set of the TOFD or UT type is 
selected. For more information, see “Setting Up the Probe-Set Hardware Connection” 
on page 133.

7. Click Save.

When you change the target acquisition unit technology for an inspection setup, the 
system verifies the configured groups, and if one or more groups are not accurate for 
this technology (that is, the element quantity (aperture), the first and last element, and 
the UT channel values are higher than the value selected in the workspace), the 
system identifies the invalid values and offers to delete them or to cancel the 
operation.
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8. Configuring the Part to Be Inspected

You can use the workspace to configure a specific part to be inspected. The part can be 
a plate, a tube, or a bar. A weld can also be configured, but this is optional.

8.1 Configuring the Part

When NDT SetupBuilder initially creates it, a workspace has a default mild steel plate 
with a simple symmetrical V weld (see Figure 8-1 on page 71).

Figure 8-1  Default plate part with simple symmetrical V weld in RayTracing view
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To configure the part to be inspected

1. On the Tools menu, click Part.
2. In the Part Definition dialog box, configure the part and weld parameters (see 

Figure 8-2 on page 72):

Figure 8-2  The Part Definition dialog box with default parameters

a) Define the part parameters (see “Configuring the Part” on page 71):
(1) Define the part material (see “Configuring the Part Material” on page 73).
(2) Define the part geometry (see “Configuring the Part Geometry” on

page 74).
(3) Define the part size in RayTracing view (see “Configuring the Part

Dimensions” on page 76).
b) Define the weld parameters (see “Defining the Weld to Be Inspected” on 

page 78).

Weld-definition viewer area

Part-geometry
parameters

area

Part-
dimensions
parameters

area

Example of a tooltip providing a parameter 
description

Weld-definition parameters area

Part-material
parameters

area
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In the Part Definition dialog box, point the mouse to each parameter to display a 
tooltip with a short description.

3. Click OK.

After the part and weld have been designed and configured, they appear in 
RayTracing view (see “RayTracing View” on page 40).

8.2 Configuring the Part Material

The part material parameters are fundamental to the inspection technique, because 
they determine the characteristics of ultrasound wave propagation in the part during 
nondestructive testing.

The Part Definition dialog box can be used to configure the part material parameters. 
For more information about accessing the dialog box, see “Configuring the Part to Be 
Inspected” on page 71.

The Material area offers the following parameters:

Name
Click the Name list to select the material of which the part is composed. The 
default value is STEEL, MILD (mild 1020 steel).

Type a portion of or the complete name within the Name list in order to reduce 
the number of items displayed in the list.
When a material is selected, the appropriate ultrasound longitudinal wave 
(longitudinal) velocity and shear wave (transverse) velocity values are 
automatically configured in the LW and SW boxes. These values can be manually 
modified.

LW
In the LW box, enter the longitudinal wave (longitudinal) velocity of the 
ultrasound waves in the material (either in meters per second [m/s] or in inches 
per microsecond [in./μs], depending on the measurement unit selected in the 
NDT SetupBuilder preferences).
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Longitudinal velocity is the speed of the ultrasound waves that have the same 
direction of vibration as their direction of travel, which means that the movement 
of the medium is in the same or opposite direction as the motion of the wave.

SW
In the SW box, enter the shear wave (transverse) velocity of the ultrasound waves 
in the material (either in meters per second [m/s] or in inches per microsecond 
[in./μs], depending on the measurement unit selected in the NDT SetupBuilder 
preferences).

Transverse velocity is the speed of the ultrasound waves that have a direction of 
vibration that is perpendicular to their direction of travel, which means that the 
movement of the medium is perpendicular to the direction of wave propagation.

The material, longitudinal velocity, and transverse velocity parameters of a part can 
be customized in order to create a custom material. The custom material is available 
only in the workspace where it has been defined. After a material’s parameters have 
been modified, an asterisk is displayed to the right of the Material list.

8.3 Configuring the Part Geometry

In a new workspace, the default part type is a plate. The following two options are 
available: tube and bar. Depending on the selected part type, you can configure the 
scan orientation (which is generally the same as the weld orientation, and only 
available for a tube or bar part), the part thickness, and/or the part diameter.

The Part Definition dialog box can be used to configure the part geometry 
parameters. For more information about accessing the dialog box, see “Configuring 
the Part to Be Inspected” on page 71.

The part geometry parameters have an influence on the probe set/wedge/group 
configuration. The Geometry area contains the following parameters:

Type 
Click the Type list to select the part shape type. Choose Plate, Tube, or Bar (see 
Figure 8-3 on page 75). The part type selected by default is Plate.
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Figure 8-3  The Type list in the Part Definition dialog box

Outside diameter 
When Tube or Bar is selected in the Type list, in the Outside diameter box, type 
the outside diameter (OD) value of the part. The default value is 200 mm. The 
Diameter box is unavailable when Plate is selected in the Type (Geometry) list.

Scan orientation 
When Tube or Bar is selected in the Type list, click the Scan orientation list to 
select the orientation of the scan axis on a tube or bar part. The scan axis is defined 
by the scanner movement. The following options are available:

— Circumferential 
Choose Circumferential to inspect a path that runs along the circumference 
of the tube or bar part.

— Axial 
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Choose Axial to inspect a path that runs along the length of the tube or bar 
part.

The weld orientation determines the scan axis on a tube or bar part for the 
inspection technique. The Scan orientation list is unavailable when Plate is 
selected from the Type list.

Thickness 
In the Thickness box, enter a value for the thickness of the part. The thickness is 
constant for the entire part, and is defined by the shortest distance between the 
outer and inner surfaces of a part. The default thickness value is 15 mm. The 
Thickness box is unavailable when Bar is selected from the Type list.

8.4 Configuring the Part Dimensions

The Part Definition dialog box can be used to configure the part dimension 
parameters.

When the RayTracing view is set to Top (C) view, Side (B) view, or End (D) view, the 
part dimension parameters define the length of the RayTracing view axes. When the 
RayTracing view is set to 3-D view, the part display-size parameters define the 
dimensions of the part in the 3-D view.

For more information about accessing the Part Definition dialog box, see 
“Configuring the Part to Be Inspected” on page 71.

The following parameters can be configured for the part display size:

Length 
In the Length box, enter a value for the length of the part in RayTracing view. For 
a plate part, the length is parallel to the scan axis. For a tube or bar part, the length 
is measured along the cylinder’s axis. In 2-D view, the part’s length value will be 
split in half between negative and positive values on the RayTracing view axes. 
The default value is 200 mm.
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Width 
When Plate is selected in the Type list (under Geometry), in the Width box, type a 
value for the total index axis width in RayTracing view. In 2-D view, the width of 
the index axis will be split in half between negative and positive values on the 
RayTracing view axes. The default value is 200 mm.

The Width box is unavailable when Tube or Bar is selected in the Type list under 
Geometry (see Figure 8-4 on page 77).

When the RayTracing view is set to 3-D view, the values entered in the Length and 
Width boxes determine the size of the displayed plate part.

Figure 8-4  RayTracing view automatic Width parameter adjustment example

NOTE
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Angular opening 
In the Angular opening box, for a tube part, enter a value in degrees for the 
portion of the tube section that is to be displayed in RayTracing view. The default 
value is 360°, which means the entire section of the tube part is displayed.

The Angular opening box is unavailable when Plate or Bar is selected in the Type 
list under Geometry.

When the RayTracing view is set to 3-D view, the values entered in the Length and 
Angular opening boxes determine the size of the displayed tube part.

8.5 Defining the Weld to Be Inspected

If you want to configure the weld to be inspected using a technique defined in the 
workspace, there are six predefined configurations available in the Weld Template 
list. Three symmetry options are available in the Symmetry list. The weld dimension 
parameters can be modified individually for the inspection technique’s requirements. 
The weld representation is dynamically updated in the graphical representation zone 
located on the right-hand side of the Part Definition dialog box.

8.5.1 Weld Regions

NDT SetupBuilder provides setup parameters that can be used to precisely define the 
different regions of a weld. The weld regions and their parameters are defined as 
follows (see Figure 8-5 on page 79):
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Figure 8-5  The parts and parameters of a weld definition

• Fill: The topmost region of a weld. For a tube, this region is closest to the outside 
diameter (OD). This region extends at an angle from the hot pass to the top of the 
piece. A fill with a zero-degree (0°) angle relative to the weld centerline is vertical.
In NDT SetupBuilder, the parameters that define the fill region are the fill Height 
and Angle.

In some actual weld definitions, the fill may be subdivided into fill and upper fill 
regions, or it may be subdivided into several regions, each with a specific fill angle 
and fill height. The upper fill region is also known as the cap. NDT SetupBuilder 
supports only one fill.

• Hot pass: The region just below the fill of the weld. This region receives the 
second pass during the welding process. The hot pass can be of two bevel types 
(see Figure 8-6 on page 80):

Fill

Hot pass

Land

Root

Fill height

Fill angle

Hot-pass
height

Land height

Root height

Hot-pass 
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Root 
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Land offset
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Fill
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Figure 8-6  Hot-pass types

— U-type: Defined by a radius measured between the hot pass and the fill. The 
radius extends to the point where it becomes tangential to the fill region 
(where it crosses, or touches the fill region’s angle). In NDT SetupBuilder, the 
fill walls are vertical when the angle is zero degrees (0°) relative to the weld 
centerline. The U-type hot pass as defined here is also known as a J-type hot 
pass.

— V-type: The V-type hot pass is comprised of an angled wall, the height of 
which is measured between the hot pass and the fill.

In NDT SetupBuilder, the parameters that define the hot-pass region are the hot-
pass Bevel type, Height, and Angle.

• Land: This is the vertical region above and below the area in which the first pass 
is placed during the welding process. The land region itself is not welded. The 
weld walls join together in this region. An offset or a gap may optionally separate 
the walls of the land region, and may include an empty space when the weld is 
completed.
In NDT SetupBuilder, the parameters that define the land region are the land 
Height and Offset.

In CRC-type bevels, the land region is known as lack of cross-penetration (LCP).

• Root: This region extends at an angle from below the land region to the bottom of 
the piece. For a tube, this region is closest to the inside diameter (ID). This is the 
region where the root pass is placed during the welding process. The root is not 
always part of a weld definition.

U-type V-type
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In NDT SetupBuilder, the parameters that define the root region are the root 
Height and Angle.

The root of the weld is also known as the root fill.

8.5.2 Basic Weld Shape Templates

NDT SetupBuilder provides the following six basic weld shape templates (see 
Figure 8-7 on page 81):

Figure 8-7  Available weld shape templates

• V: A weld type comprised of a fill, a V-shaped hot pass, and a land. There is no 
predefined root.

• V Offset: A weld type comprised of a fill, a V-shaped hot pass, and a land with an 
offset or gap. There is no predefined root.

NOTE

V V Offset Double V

Double V Offset J U
Configuring the Part to Be Inspected

 
81



DMTA-20090-01EN, Rev. B, September 2022
• Double V: A weld type comprised of a fill, a V-shaped hot pass, a land, and a 
V-shaped root.

• Double V Offset: A weld type comprised of a fill, a V-shaped hot pass, a land 
with an offset or gap, and a V-shaped root.

• J: A weld type comprised of a fill with facing vertical walls, a J-shaped hot pass, a 
land, and a V-shaped root.

• U: A weld type made of a fill, a U-shaped hot pass, and a land. There is no 
predefined root.

The Double V, Double V Offset, and J weld templates provide a predefined root 
region.

8.5.3 Weld Symmetry

In NDT SetupBuilder, there are three different types of weld symmetry (see Figure 8-8 
on page 82):

Figure 8-8  Available weld symmetry options

• Symmetrical: Weld type with symmetrical wall configurations along the weld 
center line.

• Flat Right-Hand Side (RHS): Asymmetrical weld type, with one vertical flat wall 
parallel to the weld center line on the right-hand side, and appropriate fill, hot 
pass, land, and root walls on the left-hand side.
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• Flat Left-Hand Side (LHS): Asymmetrical weld type, with one vertical wall 
parallel to the weld center line on the left-hand side, and appropriate fill, hot pass, 
land, and root walls on the right-hand side.

The flat right-hand side (RHS) and flat left-hand side (LHS) weld types are also 
known as K-type welds.

8.5.4 Weld Configuration

In NDT SetupBuilder, the weld is an optional parameter under Part Definition. This 
means that you are able to configure an inspection setup with a part that does not 
include a weld.

The weld is defined by configuring the parameters for the different weld regions (see 
“Weld Regions” on page 78) in the Part Definition dialog box (see Figure 8-9 on 
page 84). For more information about accessing the dialog box, see “Configuring the 
Part to Be Inspected” on page 71.
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Figure 8-9  The Part Definition dialog box with the Weld area

In the Part Definition dialog box, two views (Top view and an End view) display the 
shape of the configured weld, and are updated dynamically as parameters are set or 
modified.

Only positive values can be entered for weld parameters. Regions with a height 
parameter value set to 0 (zero) are not displayed in the weld definition.

Configure the following parameters for the weld regions applicable to the inspection 
setup:

Weld
Select the Weld check box if you want to include a weld definition for the part 
defined in the inspection setup, and to make the weld parameters available in the 
Part Definition dialog box. By default, the Weld check box is selected for a plate 
or a tube part.

Top view of part and weld

End view of part and weld

Weld configuration 
area
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Clear the Weld check box to define a part without a weld. When the Weld check 
box is cleared, the weld parameters are unavailable in the Part Definition dialog 
box.

Weld Template
In the Weld Template list, select a weld template with the appropriate weld 
symmetry for your inspection setup (see Figure 8-10 on page 85):

Figure 8-10  The Weld Template list

— V
— V Offset
— Double V
— Double V Offset
— J
— U
The weld templates available in NDT SetupBuilder correspond to those available 
with OmniScan instruments. For more information about the available weld 
templates, see “Basic Weld Shape Templates” on page 81.

By default, the V weld template is selected. Selecting a weld template sets the 
original values of all of the weld parameters, and provides a basis on which to 
refine your weld configuration in line with the inspection setup.
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By default, only the Double V, Double V Offset, and J weld templates offer a 
predefined root region.

Symmetry
In the Symmetry list, select the appropriate weld symmetry:

— Symmetrical
— Flat Right-Hand Side (RHS)
— Flat Left-Hand Side (RHS)
By default, the Symmetrical type is selected in the Symmetry list. For more 
information about the available weld symmetry types, see “Weld Symmetry” on 
page 82.

Fill
In the Fill area, the following two parameters define the fill region:

Height 
To configure the fill region’s height, enter a value in the Height box. This 
measurement is always taken parallel to the weld center line.

Angle 
To configure the wall angles of the fill region, enter a value in the Angle box. 
The fill angle is defined as the angle between the fill bevel and a line parallel 
to the center line.

Hot Pass
The the Hot Pass area contains the following three parameters, which define the 
hot-pass region:
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Bevel Type 
In the Bevel Type list, select the appropriate hot-pass bevel type: choose U or 
V. For more information about hot-pass bevel types, see “Weld Regions” on 
page 78.

A hot-pass bevel type is originally set according to the weld type selected in the Weld 
template list. The Bevel Type list provides additional options that can be used to 
define the hot pass more precisely.

Height 
To configure the hot-pass region’s height, enter a value in the Height box. 
This measurement is always taken parallel to the weld center line.

Angle 
To configure the wall angles of the hot-pass region, enter a value in the Angle 
box. The hot-pass angle is defined as the angle between the hot-pass bevel 
and a line parallel to the weld center line. The maximum usable value for the 
hot-pass region wall angle is 89.9°, and the minimum height value is 0.0 mm. 
A hot-pass height value of 0.0 mm means that no hot pass is defined. A 
minimal value greater than 0.0° is needed to define the hot pass angle.
When the bevel type selected in the Bevel Type list is U, the Angle box is 
unavailable.

Land
In the Land area, the following two parameters define the land region:
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Height 
To configure the land region’s height, enter a value in the Height box. This 
measurement is always taken parallel to the weld center line.

Offset 
To configure the gap between one of the land region’s walls and the weld 
center line, enter a value in the Offset box. The total gap measurement 
between the two walls of the land is two times the value displayed in the 
Offset box. Specify the minimal distance between either side of the weld and 
the center line. This measurement is always taken perpendicular to the weld 
center line.
When the bevel type selected in the Bevel Type list is U, the Offset box is 
unavailable.

Root
In the Root area, the following two parameters define the root region:

Height 
To configure the root region’s height, enter a value in the Height box. This 
measurement is always taken parallel to the weld center line.

Angle 
To configure the wall angles of the root region, enter a value in the Angle box.
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By default, in the Root area, the Height box and the Angle box parameters have a 
value of 0, except when the template selected in the Weld Template list is Double V, 
Double V Offset, or J. Only the Double V, Double V Offset, and J weld templates 
offer a predefined root region.
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9. Configuring One or More Probe Sets

In NDT SetupBuilder, the probe sets for a given inspection setup are configured from 
the Probe Sets tab. The Probe Sets tab provides tools and parameters that can be used 
to configure the probes and wedges included in the probe sets.

The Probe Sets tab contains a toolbar that provides basic probe-set definition 
commands (see Figure 9-1 on page 91).

Figure 9-1  The Probe Sets tab toolbar

Several of the Probe Sets tab’s commands can be activated using keyboard shortcuts. 
For more information, see “Accessing Commands Using Keyboard Shortcuts” on 
page 31.

The Probe Sets tab columns provide parameters that can be used to configure the 
probe sets:

• To define probe sets, see:
— “Setting Probe-Set Visibility” on page 97.

Clone Probe buttonDelete Probe buttonAdd Probe button Flip Probe button
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— “Configuring Probe-Set Position Parameters” on page 130.
• To define a probe set’s probes, see:

— “Selecting a Probe Series and Model” on page 100.
— “Managing Custom Probe Models” on page 103.

• To define a probe set’s wedge, see:
— “Selecting a Wedge Series and Model” on page 114.
— “Managing Custom Wedge Models” on page 116.

On the Probe Sets tab, point the mouse to each column header or toolbar element to 
display a tooltip with a short description of the applicable parameter or function.

RayTracing view can be used to visualize the probe sets being configuring for a 2-D or 
3-D inspection setup, with the exception of dual matrix-type probe sets, which are not 
displayed. For more information, see “RayTracing View” on page 40.

When a probe set is selected on the Probe Sets tab, it becomes highlighted in 
RayTracing view. For more information, see “Identifying Selected Probe Sets in 
RayTracing View” on page 32.

The tools needed to configure probe-set groups are located on the Groups tab. For 
more information about configuring groups, see “Configuring One or More Groups” 
on page 137.

9.1 Adding a Probe Set

The Probe Sets tab toolbar can be used to insert one or more probe sets in an 
inspection setup. The probe-set parameters can also be configured from the Probe Set 
section.

To add a probe set

 Click the Add Probe button ( ) on the Probe Sets tab toolbar.
A new probe set is added in the Probe Sets tab table. This table can be used to set 
or modify the following probe-set definition parameters: Visible, Name, and 
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Type. For more information about these parameters, see “Configuring the Probe-
Set Section Parameters” on page 99.

When a new probe set of the TOFD or UT type is added, an associated group is also 
automatically created on the Groups tab. Adding a probe set of the PA linear or dual 
matrix type does not automatically create a group. For more information about 
creating and configuring groups, see “Configuring One or More Groups” on 
page 137.

9.2 Deleting a Probe Set

The Probe Sets tab toolbar can be used to delete one or more probe sets in an 
inspection setup.

To delete a probe set

1. In the list under the Probe Sets tab, select one or more probe sets you want to 
delete (see Figure 9-2 on page 93).

Figure 9-2  Selecting a probe set on the Probe Sets tab for deletion

2. Click the Delete Probe button ( ) on the Probe Sets tab toolbar.
The selected probe sets are deleted from the list under the Probe Sets tab.

When you delete a probe set, all the groups associated with it are simultaneously 
deleted from the Groups tab.

text
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9.3 Cloning a Probe Set

The Probe Sets tab toolbar can be used to clone one or more probe sets in an 
inspection setup. When cloning a probe set, the groups associated with it are also 
cloned on the Groups tab.

To clone a probe set

1. In the list under the Probe Sets tab, select the probe set or sets you want to clone 
(see Figure 9-3 on page 94).

Figure 9-3  Selecting a probe set on the Probe Sets tab for cloning

2. Click the Clone Probe button ( ) on the Probe Sets tab toolbar.
The cloned probe sets are added to the list under the Probe Sets tab.

Use the Clone Probe button ( ) in combination with the Flip Probe button ( ) on 
the Probe Sets tab toolbar to create a pair of opposing probe sets. For more 
information about the Flip Probe button, see “Flipping a Probe Set” on page 95.
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9.4 Flipping a Probe Set

The Probe Sets tab toolbar can be used to flip one or more probe sets in an inspection 
setup. Flipping a probe set switches the skew parameter values between 0° and 180°, 
or 90° and 270°, and inverts the sign of the index offset parameter value. For more 
information about the index offset parameter, see “Configuring Probe-Set Position 
Parameters” on page 130.

To flip a probe set

1. In the list under the Probe Sets tab, select one or more probe sets you want to flip 
(see Figure 9-4 on page 95).

Figure 9-4  Selecting a probe set on the Probe Sets tab for flipping

2. Click the Flip Probe button ( ) on the Probe Sets tab toolbar.
The selected probe sets’ skew and index offset parameters are modified in the list 
under the Probe Sets tab.

Use the Flip Probe button ( ) in combination with the Clone Probe button ( ) on 
the Probe Sets tab toolbar to create a pair of opposing probe sets. For more 
information about the Clone Probe button, see “Cloning a Probe Set” on page 94.
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9.5 Configuring the Parameters of Probe Sets

When defining or modifying a probe set on the Probe Sets tab, it is also possible to 
configure the available parameters identified on the tab’s column headers (see 
Figure 9-5 on page 96).

Figure 9-5  The Probe Sets tab column headers

To configure probe-set parameters

1. From the list under the Probe Sets tab, select the probe set you want to configure 
(see Figure 10-12 on page 146).

Figure 9-6  Selecting a probe set on the Probe Sets tab to configure parameters

2. In the Probe Set section, set the probe-set visibility. For more information, see 
“Setting Probe-Set Visibility” on page 97.

3. In the Probe Set section, configure the probe-set name and type parameters. For 
more information, see “Configuring the Probe-Set Section Parameters” on 
page 99.

text
Chapter 9

 
96



DMTA-20090-01EN, Rev. B, September 2022
4. In the Probe section, select the probe-set probe series and models. For more 
information, see “Selecting a Probe Series and Model” on page 100.

5. In the Wedge section, select the wedge series and models. For more information, 
see “Selecting a Wedge Series and Model” on page 114.

6. In the Position section, configure the probe-set position parameters. For more 
information, see “Configuring Probe-Set Position Parameters” on page 130.

7. In the Hardware Connection section, configure the probe-set hardware 
connection parameters. For more information, see “Setting Up the Probe-Set 
Hardware Connection” on page 133.

9.5.1 Setting Probe-Set Visibility

In RayTracing view, the probe-set visibility can be set using the check box in the 

Visible column ( ) on the left side of the probe-set parameters table under the 
Probe Sets tab. By default, a probe set is visible and the check box selected upon 
creation (see Figure 9-7 on page 98). If a probe set’s Visible check box is cleared, the 
groups associated with the probe set also become invisible, and they cannot be made 
visible in RayTracing view unless the probe set is displayed.

It is possible to independently set the visibility of the groups associated with a visible 
probe set. For more information, see “Setting Group Visibility” on page 144.
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Figure 9-7  The Probe Sets tab with the Visible check box selected

To set the probe-set visibility

 Do one of the following:
— To show the probe set and all related groups in RayTracing view, select the 

Visible column ( ) check box (see Figure 9-7 on page 98).
— To hide the probe set and all related groups in RayTracing view, clear the 

Visible column ( ) check box (see Figure 9-8 on page 99).
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Figure 9-8  A probe set with the Visibility check box cleared on the Probe Sets tab

9.5.2 Configuring the Probe-Set Section Parameters

The Probe Sets tab can be configured using the probe-set parameters in the Probe Set 
section.

The items available in the Type list in the Probe Set section change based on the 
acquisition unit selected for the inspection setup. For more information about 
selecting an acquisition unit, see “Selecting an Acquisition Unit” on page 65.

To configure the probe-set section parameters

 On the Probe Sets tab, under Probe Set, configure the following parameters:
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Name
In the Name box, enter a name for the probe set. By default, the name New n 
is automatically generated. The probe-set name can contain a maximum of 15 
characters.

Type
In the Type list, select the appropriate type of probe set to be used in the 
inspection setup:

○ PA Linear: For phased array inspection. By default, PA Linear is selected 
in the list.

○ After creating a PA linear-type probe set, you must manually create one 
or more groups and associate them with the probe set.

○ TOFD: For time-of-flight diffraction inspection.
○ When you create a TOFD-type probe set, a pitch-catch group is 

automatically created and associated with the probe set.
○ UT: For ultrasound inspection.
○ When you create a UT-type probe set, a single pulse-echo group is 

automatically created and associated with the probe set.
○ Dual Matrix: for phased array dual inspection.
○ When you create a dual matrix-type probe set, you must manually create 

one or more groups and associate them with the probe set.
The type of probe set selected in the Type list determines which items are 
displayed in the Series list under Probe.

When you change the Type of a probe set, the groups that are associated with it are 
deleted from the Groups tab.

For more information about creating and configuring groups, see “Configuring One 
or More Groups” on page 137.

9.5.3 Selecting a Probe Series and Model

NDT SetupBuilder provides a list of available Evident probe series and models, and it 
is possible to select a probe series and model from the predefined lists. The list of 
available probe series and models only displays items that are compatible.
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If the probe series and models available in the predefined lists do not accurately 
reflect the probe required for your inspection setup, you can define a customized 
probe. Custom probes are created using the Probes command from the Tools menu 
(see “Managing Custom Probe Models” on page 103). Custom probes are displayed 
separately in the list.

In the Series list, select Custom to display the list of custom probes available in the 
Model list under the Probe Sets tab. You can then select the appropriate existing 
custom probe to edit it.

To select a probe series and model

 On the Probe Sets tab, under Probe, select a probe series and model from the 
following lists:
Series

In the Series list, select the appropriate series of probe to be used in the probe 
set:

○ Angle Beam: Select Angle Beam to display the list of existing angle-beam 
probes in the Model list.

○ Immersion: Select Immersion to display the list of existing immersion 
probes in the Model list.

○ Contact: Select Contact to display the list of existing contact probes in the 
Model list.

○ Dual: Select Dual to display the list of existing pitch-catch (pulser-
receiver) probes in the Model list.

○ Straight Beam: Select Straight Beam to display the list of straight-beam 
probes in the Model list.

○ Integrated Wedge: Select Integrated Wedge to display the list of existing 
integrated-wedge probes in the Model list.

○ Custom: Select Custom to display the list of existing custom probes in the 
Model list. To edit a custom probe or use it in the inspection setup, select 
it from the Model list.

The probe-series list displays only those series that are compatible with the 
probe-set type selected in the Type list under Probe Set.
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For PA linear-type and dual matrix-type probe sets, the Series list provides a 
complete listing of the different series of probe mounts available in the Evident probe 
and wedge catalog.

Model 
In the Model list, select the appropriate probe model to be used in the probe 
set.

The list of probe models displays only those models that are compatible with 
the probe-set type selected in the Type list under Probe Set and the probe 
series selected in the Series list under Probe.

9.5.4 Identifying the First Element on a Probe

The first element of a probe is visually identified by a red outline in RayTracing view 
(see Figure 9-9 on page 103). You can reverse the position of the first element of a 
probe in conjunction with certain wedges from the wedge series. For more 
information, see “Configuring Probe-Set Position Parameters” on page 130.

NOTE
Chapter 9

 
102



DMTA-20090-01EN, Rev. B, September 2022
Figure 9-9  The first element of a probe is identified in RayTracing view

9.5.5 Managing Custom Probe Models

The NDT SetupBuilder workspace allows you to define custom probes that accurately 
comply with your inspection setup, or delete custom probes. On the Probe Sets tab, 
under Probe, existing custom probe models are displayed in the Model list when 
Custom is selected in the Series list. The custom probes created are then saved to the 
open workspace.

To manage custom probe models

1. On the Tools menu, click Transducers to access the probe settings (see Figure 9-10 
on page 104).

First element of probe (outlined in
red)

Probe
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Figure 9-10  Accessing the probe settings on the Tools menu

The Manage Probes dialog box appears (see Figure 9-11 on page 105). This dialog 
box contains the following three areas:
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Figure 9-11  The Manage Probes dialog box

In the Manage Probes dialog box, point the mouse to each parameter to display a 
tooltip with a short description.

— Available Probes: This area provides lists that allow you to select a probe 
from predefined probe-set types, probe series, and probe models. The Add 
and Remove buttons can be used to create a custom probe based on a 
predefined model selected from the lists or to delete an existing custom 
probe.

— Model Characteristics: This area displays the parameters of the probe model 
selected in the Available Probes area. For a predefined probe, these 
parameters are unavailable. When you create a custom probe model, the 
parameters become editable.

— Probe parameters diagram: This area identifies the probe’s primary axis, 
secondary axis, width, and pitch parameters.

Available Probes area Model Characteristics area

The Add and Remove buttons that 
are used to create custom probes

Example of a tooltip providing a parameter 
description
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2. Under Available Probes, select a probe to use as the basis for your custom probe:
Type

In the Type list, select the appropriate type of probe set you want to use in the 
inspection setup:

○ PA Linear: For phased array inspection. By default, PA Linear is selected 
in the list.

○ UT: For ultrasound inspection.
○ TOFD: For time-of-flight diffraction inspection.
The type of probe set selected in the Type list determines the probe options 
displayed in the Series list.

Series
In the Series list, select the appropriate probe series to be used:

○ Angle Beam: Select Angle Beam to display the list of existing angle-beam 
probes in the Models list.

○ Contact: select Contact to display the list of existing contact probes in the 
Model list.

○ Dual: Select Dual to display the list of existing pitch-catch (pulser-
receiver) probes in the Models list.

○ Immersion: Select Immersion to display the list of existing immersion 
probes in the Models list.

○ Straight Beam: Select Straight Beam to display the list of straight-beam 
probes in the Models list.

○ Integrated Wedge: Select Integrated Wedge to display the list of existing 
integrated wedge probes in the Models list.

○ Custom: Select Custom to display the list of existing custom probes in the 
Models list. You can then edit the appropriate custom probe by selecting 
it from the Models list.
The Custom probe series will not display unless there is at least one 
existing custom probe model saved within the workspace. For more 
information, see “Configuring Custom Probe Model Parameters” on 
page 108.

The Series list displays only those options that are compatible with the probe 
type selected in the Type list.
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For PA linear-type probe sets, the Series list provides a complete listing of the 
different series of probe mounts available in the Evident probe and wedge catalog, 
and the default probe set series is A2.

Models 
In the Models list, select the appropriate probe model to be used.

The list of probe models displays only those models that are compatible with 
the probe-set type selected in the Type list, and the probe series selected in the 
Series list.

3. Do one of the following:
— To delete a custom probe, select it in the Models list under Available Probes, 

and then click Remove (see Figure 9-12 on page 107).

Figure 9-12  The Manage Probes dialog box and a new probe

The selected custom probe is deleted from the Models list.
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— To modify a custom probe, select it in the Models list under Available 
Probes.
The parameters of the selected custom probe will now be available under 
Model Characteristics.

— To add a custom probe, click Add.
When a custom probe is selected in the Models list, it is automatically 
populated in the Name box under Model Characteristics (see Figure 9-12 on 
page 107). The name of the new probe is marked by an asterisk and it can be 
edited. The parameters under Model Characteristics become available.

4. Configure the probe parameters according to the specifications for the inspection 
setup.
For details on configuring probe parameters when creating or modifying a 
custom probe model, see “Configuring Custom Probe Model Parameters” on 
page 108.

5. Perform one of the following actions:
— Click Reset to reset the selected custom probe model parameters in the 

Models list under Available Probes.
— Click Apply to save the custom probe model in the Models list under 

Available Probes.
— Click Close to save the custom probe model in the Models list under 

Available Probes and close the dialog box.

9.5.6 Configuring Custom Probe Model Parameters

The Manage Probes dialog box can be used to create, modify, or delete custom 
probes. For more information about managing probes and accessing the dialog box, 
see “Managing Custom Probe Models” on page 103.

The following parameters can be configured in the Manage Probes dialog box:

Name
In the Name box, enter the name of the custom probe. By default, the name 
New n is automatically generated for custom probes. The probe name can contain 
a maximum of 15 characters.

Frequency 
In the Frequency box, enter the frequency of the custom probe.
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Shape 
For a UT-type probe set only, in the Shape list, select the custom probe’s element 
shape: Rectangular or Circular. By default, Rectangular is selected in the list.

For a probe set of the PA linear or TOFD type, the Shape list is unavailable, and its 
value is set to Rectangular.

Primary Axis
In the Primary Axis area, configure the Pitch/Side 1 length/Diameter and 
Element quantity settings for your custom probe model definition:

Pitch/Side 1 length/Diameter 
The name in this box changes according to the type of probe set selected in 
the Type list under Available Probes. For TOFD or UT probe-set types, the 
box’s name also changes according to the shape of the probe displayed in the 
Shape box under Model Characteristics.

For a probe set of the PA linear type, in the Pitch box, enter the element pitch, 
which is the spacing (center-to-center distance) between consecutive probe 
elements on the primary axis of the custom probe model.

In the Side 1 length box, for a probe set of the TOFD or UT type with a 
rectangular shape, enter the length of the element on the primary axis of the 
custom probe model.

In the Diameter box, for a probe set of the TOFD or UT type with a circular 
shape, enter the diameter of the custom probe model.

In NDT SetupBuilder, the width value of a single element of a probe is used as the 
element pitch value.

NOTE
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Element quantity
In the Element quantity box, enter the number of elements that comprise the 
probe on the primary axis of the custom probe model.

Secondary Axis
In the Secondary Axis area, configure the Elevation/Side 2 length setting for 
your custom probe definition:

Elevation/Side 2 length 
The name in this box changes according to the type of probe set selected in 
the Type list under Available Probes. For TOFD or UT probe-set types, the 
box’s name also changes according to the shape of the probe displayed in the 
Shape box under Model Characteristics.

For a PA linear-type probe set, in the Elevation box, enter the elevation (the 
element width) of the elements of the custom probe model along the secondary 
axis. For a probe set of the TOFD or UT type with a circular shape, enter the 
diameter of the custom probe model.

For a probe set of the TOFD or UT type with a rectangular shape, in the Side 
2 length box, enter the length of the element on the secondary axis of the 
custom probe model.

9.5.7 Deactivating and Activating Phased Array Probe Elements

When configuring an inspection setup for a PA linear- or dual matrix-type probe set, 
NDT SetupBuilder provides functions to individually deactivate or activate elements 
from the PA linear or dual matrix probes already created in your workspace. The 
functions for deactivating or reactivating probe elements are unavailable for the other 
types of probes.

Deactivating probe elements is especially useful when one or more of a probe’s 
elements have become nonfunctional, or dead. The nonfunctional elements can be 
deactivated from within the inspection setup configuration using the Deactivate 
Elements command from the Tools menu.
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In the Deactivate Elements dialog box, point the mouse to each parameter to display 
a tooltip with a short description.

To deactivate or activate phased array probe elements

1. On the Tools menu, click Deactivate Elements (see Figure 9-13 on page 111).

Figure 9-13  Selecting the Deactivate Elements command from the Tools menu

The Deactivate Elements dialog box appears (see Figure 9-14 on page 112 and 
Figure 9-15 on page 112). The dialog box contains the following parameters:

NOTE
Configuring One or More Probe Sets

 
111



DMTA-20090-01EN, Rev. B, September 2022
Figure 9-14  The Deactivate Elements dialog box for a PA linear probe

Figure 9-15  The Deactivate Elements dialog box for a dual matrix probe

2. From the Probe Set list, select the appropriate probe set.
All the PA linear- or dual matrix-type probe sets available in your workspace are 
displayed in the list.

3. To deactivate an element, click it in the grid (see Figure 9-16 on page 113 and 
Figure 9-17 on page 113).

Probe Set list

Probe Set list
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Figure 9-16  The Deactivate Elements dialog box for a PA linear probe

For a PA linear-type probe, all the elements are in sequential order from top to 
bottom in the rows displayed under Tx (see Figure 9-16 on page 113).

Figure 9-17  The Deactivate Elements dialog box for a dual matrix probe

For a dual matrix probe, the elements from the pulser probe are regrouped under 
Tx, and the elements from the receiver probe are regrouped under Rx (see 
Figure 9-17 on page 113).

4. Perform one of the following actions:
— Click Reset to reset the deactivated elements.
— Click Apply to save the deactivated elements for the selected probe set.

Deactivated elements on the PA linear matrix

Deactivated elements on the Tx and Rx 
matrices
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— Click Close to save the deactivated elements for the selected probe set and 
close the dialog box.

An inspection setup that contains deactivated elements can only be sent to an 
OmniScan instrument as one or more .law files. For more information on exporting an 
inspection setup to a .law file, see “Exporting a Workspace as a .law File” on page 164.

9.5.8 Selecting a Wedge Series and Model

NDT SetupBuilder provides a list of wedge series and models available for the 
Evident ultrasound and phased array probe sets. Wedge series and models can be 
selected from the predefined lists. The lists of available wedge series and models 
display only those items that are compatible with the selected probe series and model.

If the wedge series and models available in the predefined lists do not accurately 
describe the inspection setup, custom probes, which are displayed separately in the 
list, can also be defined (see “Managing Custom Probe Models” on page 103).

To select a wedge

 On the Probe Sets tab, under Wedge, select a wedge series and model from the 
following lists:
Series

In the Series list, select the appropriate series of the wedge to be used for the 
probe set:

○ Angle: Select Angle to display the list of existing angle-beam wedges in 
the Model list. This series is selected by default for UT-type probe sets.

○ Contact: Select Contact to display the list of existing contact wedges in 
the Model list.

○ Integrated: Select Integrated to display the list of existing integrated 
wedges in the Model list.

○ SA2: Select SA2 to display the list of existing SA2-series wedges in the 
Model list. This series is selected by default for PA linear-type probe sets. 
For the PA linear probe-set type, additional wedge series may be 
available; for example, the following wedge series may be displayed: 
ABWX-MWUX, CustomSA, SAn, SAWn, SIn, SNWn, and SPWZn.
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For PA linear-type and dual matrix-type probe sets, the Series list provides a 
complete listing of the different series of available wedges categorized by probe 
mount, as detailed in the Evident probe and wedge catalog.

○ TOFD: Select TOFD to display the list of existing TOFD-series wedges in 
the Model list. This series is selected by default for a probe set of the 
TOFD type.

○ Wedge: Select Wedge to display the list of existing wedge-series wedges 
in the Model list. This wedge series is available only when PA Linear is 
selected in the Type list for the probe set.

○ Custom: Select Custom to display the list of existing custom wedges in 
the Model list. The appropriate custom wedge can then be selected from 
the Model list for use in the inspection setup, or it can be edited.
The Custom wedge series is not displayed unless there is at least one 
existing custom-wedge model saved in the workspace. For more 
information, see “Managing Custom Wedge Models” on page 116.

Not all wedge series are available for all probe-set types. For more information about 
the wedge series available for each type of probe set, see Table 7 on page 115.

Table 7  Available wedge series on the Probe Sets tab 

Probe-set type
PA linear TOFD UT Dual matrix

Wedge series
Angle —  a —

Contact    —

Integrated —   —

SA2, ABWX-
MWUX, CustomSA, 
SAn, SAWn, SIn, 
SNWn, and SPWZnb

c — — 
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Model 
In the Model list, select the appropriate wedge model to be used for the probe 
set. The list of displayed wedge models is determined by the probe-set type 
that has been selected in the Type list under Probe Set and the wedge series 
selected in the Series list under Wedge.

9.5.9 Managing Custom Wedge Models

In your workspace, NDT SetupBuilder allows you to define custom wedges that 
accurately correspond to your inspection setup or delete existing custom wedges. 
When Custom is selected in the Series list on the Probe Sets tab under Wedge, 
custom wedge models are displayed in the Model list. The custom wedges you create 
are saved exclusively in the open workspace.

To manage custom wedge models

1. On the Tools menu, click Wedges (see Figure 9-18 on page 117).

TOFD — d  —

Wedge  — — —

Custome    —

a. Angle is the default wedge series for the UT probe-set type.
b. Additional wedge series are available for the PA linear probe-set type only. The following 

series of wedges may be displayed: SA2, ABWX-MWUX, CustomSA, SAn, SAWn, SIn, 
SNWn, and SPWZn. The list of different series of available wedges is categorized by probe 
mount, as detailed in the Evident probe and wedge catalog.

c. SA2 is the default wedge series for the PA linear probe-set type.
d. TOFD is the default wedge series for the TOFD probe-set type.
e. The Custom wedge-series option becomes available when at least one custom wedge mod-

el has been saved for that wedge series.

Table 7  Available wedge series on the Probe Sets tab (continued)

Probe-set type
PA linear TOFD UT Dual matrix

Wedge series
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Figure 9-18  Selecting the Wedges command from the Tools menu

The Manage Wedges dialog box appears (see Figure 9-19 on page 118). This 
dialog box contains the six following areas:
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Figure 9-19  The Manage Wedges dialog box

In the Manage Wedges dialog box, point the mouse to the each parameter to display a 
tooltip with a short description.

Available Wedges area Model Characteristics area End, Side, and Top views for wedge rendering

Probe Model for Display area
Select a probe model to be included in the wedge rendering inside the dialog box.

The Add and Remove buttons are used to create custom wedge models.

Forward area
Reverse area
The Reverse area changes into the Fluid area when 
Immersion is selected in the Series list under 
Available Wedges.

Example of a tooltip 
providing a parameter 

description
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— Available Wedges: This area provides lists that allow you to select a wedge 
model from among predefined probe-set types, wedge series, and wedge 
models. The Add and Remove buttons can be used to create a custom wedge 
based on a predefined model selected using the lists or to delete an existing 
custom wedge.

— Probe Model for Display: This area provides a list that can be used to select a 
probe model to be included in the graphical representations of the wedge 
displayed in the dialog box’s End, Side, and Top views.

The probe model displayed in the main window’s RayTracing view is the same probe 
model selected in the Model list under Probe on the Probe Sets tab. The probe model 
selected in the Probe Model for Display area in the Manage Wedges dialog box does 
not change the selection on the Probe Sets tab.

— Model Characteristics: This area displays the wedge-model parameters 
selected in the Available Wedges area. For a predefined wedge, these 
parameters are unavailable. When you create a custom wedge model, the 
parameters become editable.

— Forward: This area displays the wedge-model parameters indicating that the 
probe can be mounted with a zero-degree (0°) orientation on the wedge. 
These parameters are unavailable for a predefined wedge. When you create a 
custom wedge model, the parameters become editable.

— Reverse: This area displays the wedge-model parameters indicating that the 
probe can be mounted with a 180° orientation on the wedge. These 
parameters are unavailable for a predefined wedge. When you create a 
custom wedge model, the parameters become editable.
Refer to the actual wedge-model technical specifications to ensure that the 
probes can be mounted with a 180° orientation on the wedge.

— End, Side, and Top views: This area provides graphical representations of the 
selected wedge model.

2. Under Available Wedges, select a predefined wedge to use as the basis for your 
custom wedge:
Type

In the Type list, select the appropriate probe-set type to be used in the 
inspection setup:
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○ PA Linear: For phased array inspection. By default, PA Linear is selected 
in the list.

○ TOFD: For time-of-flight diffraction inspection.
○ UT: For ultrasound inspection.
The type of probe set selected in the Type list determines the options 
displayed in the Series list described below.

Series
In the Series list, select the appropriate wedge series to be used for the probe 
set:

○ Angle: Select Angle to display the list of existing angle-beam wedges in 
the Model list. This series is selected by default for a UT-type probe set.

○ Integrated: Select Integrated to display the list of existing integrated 
wedges in the Model list.

○ SA2: The SA2 series is selected by default for a probe set of the PA linear 
type. For the PA linear probe-set type, additional series of wedges are 
available. For example, the following wedge series may be available: 
ABWX-MWUX, CustomSA, SAn, SAWn, SIn, SNWn, and SPWZn.

○ TOFD: The TOFD series is selected by default for a probe set of the TOFD 
type.

○ Wedge: Select Wedge to display the list of existing wedges-series wedges 
in the Model list. This wedge series is only available when PA Linear is 
selected in the Type list for the probe set.

○ Custom: Select Custom to display the list of existing custom wedges in 
the Model list. The appropriate custom wedge can then be selected from 
the Model list for use in the inspection setup, or it can be selected and 
then edited.

Not all wedge series are available for all probe-set types. For more information about 
the wedge series available for each type of probe set, see Table 8 on page 121.
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Models 
In the Models list, select the appropriate wedge model to be used for the 
probe set. The wedge-series list that is displayed is determined by the probe-
set type selected in the Type list under Available Wedges and by the wedge 
series selected in the Series list.

3. Under Probe Model for Display, select a probe series and model to be included in 
the graphical representations of the wedge that are displayed in the dialog box’s 
End, Side, and Top views:

Table 8  Available wedge series in the Manage Wedges dialog box 

Probe-set type
PA linear TOFD UT

Wedge seriesa

a. In the Manage Wedges dialog box, the Contact wedge series is not in-
cluded in the Series list under Available Wedges. The Contact wedge 
series is only available in the Series list under Wedges on the Probe Sets 
tab (see “Selecting a Wedge Series and Model” on page 114).

Angle —  b

b. Angle is the default wedge series for the UT probe-set type.

Integrated —  
SA2, ABWX-
MWUX, CustomSA, 
SAn, SAWn, SIn, 
SNWn, and SPWZnc

c. Additional wedge series are available for the PA linear probe-set type 
only. The following series of wedges may be displayed: SA2, ABWX-
MWUX, CustomSA, SAn, SAWn, SIn, SNWn, and SPWZn. The list of 
different series of available wedges is categorized by probe mount, as 
detailed in the Evident probe and wedge catalog.

d

d. SA2 is the default wedge series for the PA linear probe-set type.

— —

TOFD —  
Wedge  — —

Custome

e. The Custom wedge-series option becomes available when at least one 
custom wedge model has been saved for that series.

  
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Series
In the Series list, select the appropriate probe series to be displayed in the 
dialog box’s three views:

○ Angle Beam: Select Angle Beam to display the list of angle-beam probes 
in the Model list.

○ Contact: Select Contact to display the list of contact probes in the Model 
list.

○ Integrated Wedge: Select Integrated Wedge to display the list of 
integrated-wedge probes in the Model list.

○ Straight Beam: Select Straight Beam to display the list of straight-beam 
probes in the Model list.

○ Custom: Select Custom to display the list of existing custom probes in the 
Model list. The appropriate custom probe can then be selected from the 
Model list for use in the inspection setup, or it can be selected and edited.
The Custom probe series is not displayed unless there is at least one 
existing custom probe model saved in the workspace. For more 
information, see “Configuring Custom Probe Model Parameters” on 
page 108.

The probe-series list displays only those series that are compatible with the 
probe-set type selected in the Type list under Available Wedges.

Model 
In the Model list, select the appropriate probe model to be displayed in the 
dialog box’s three views.

The probe-models list displays only those models that are compatible with 
the probe series selected in the Series list under Probe Model for Display.

4. Under Model Characteristics, configure the parameters according to the wedge 
specifications for the inspection setup.
For details about how to configure wedge parameters when defining a new 
wedge model, see “Configuring Custom Wedge Model Parameters” on page 124.

5. Perform one of the following actions:
— To delete a custom wedge, select it in the Models list under Available 

Wedges, and then click Remove (see Figure 9-12 on page 107).
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Figure 9-20  The Manage Probes dialog box with a new probe

The selected custom wedge is deleted from the Models list.
— To modify a custom wedge, select it in the Models list under Available 

Wedges.
The parameters for the selected custom wedge will now be available under 
Model Characteristics.

— To add a custom wedge, click Add.
When adding a custom wedge under Model Characteristics, a wedge with 
the name and parameters of the model selected from the Models list is added 
(see Figure 9-12 on page 107). The name of the new wedge, marked by an 
asterisk, is displayed in the Name box, and it can be edited. The parameters 
under Model Characteristics are also now available.

6. Configure the wedge parameters according to the specifications of the inspection 
setup.
For details on how to configure wedge parameters when creating or modifying a 
custom wedge model, see “Configuring Custom Wedge Model Parameters” on 
page 124.

7. Perform one of the following actions:
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— Click Reset to reset the selected custom wedge model parameters in the 
Models list under Available Wedges.

— Click Apply to save the custom wedge model in the Models list under 
Available Wedges.

— Click Close to save the custom wedge model in the Models list under 
Available Wedges and close the dialog box.

9.5.10 Configuring Custom Wedge Model Parameters

The Manage Wedges dialog box can be used to create, modify, or delete custom 
wedges. For more information about managing wedges and accessing the dialog box, 
see “Managing Custom Wedge Models” on page 116.

The parameters from the Manage Wedges dialog box are unavailable for predefined 
wedges. When you create a custom wedge model, the parameters become editable.

When you select the predefined immersion wedge series, some of the wedge 
parameters become editable in the Model Characteristics, Forward, and Reverse 
areas.

The Manage Wedges dialog box contains the following four sections, which can be 
used to configure the custom wedge parameters (see Figure 9-21 on page 125):
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Figure 9-21  The Manage Wedges dialog box for custom wedge configuration

• Model Characteristics: This area displays the parameters of the wedge model 
selected in the Available Wedges area.

• Forward: This area displays the wedge-model parameters indicating that the 
probe can be mounted on the wedge with a zero-degree (0°) orientation.

• Reverse: This area displays the wedge-model parameters indicating that the 
probe can be mounted on the wedge with a 180° orientation. The Reverse area 
changes into the Fluid area when Immersion is selected in the Series list under 
Available Wedges.
Refer to actual wedge-model technical specifications to ensure that probes can be 
mounted on the wedge with a 180° orientation.

Available Wedges area Model Characteristics area End, Side, and Top views for wedge rendering

Probe Model for Display area
Select a probe model to be included in the wedge 
rendering inside the dialog box.

Forward area
Reverse area
The Reverse changes into the Fluid area when 
Immersion is selected in the Series list under 
Available Wedges.
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• End, Side, and Top views: This area provides graphical representations of the 
wedge model being configured. These representations are dynamically updated 
when the wedge parameters are configured.

Several of the custom wedge model parameters are configured according to wedge-
specific conventions.

The following parameters can be configured in the Manage Wedges dialog box:

Model Characteristics area
Name

Enter a name for the custom wedge model. By default, for a new custom 
wedge, the name of the currently selected wedge model marked by an 
asterisk ([Wedge Model Name]*) is automatically generated. The name of a 
wedge model can contain a maximum of 15 characters.

It is recommended to include the name of the probe model for which the wedge 
model has been configured in the custom wedge’s name.

Length 
Enter a value indicating the actual length of the wedge.
For a cylindrical part with a curvature along the primary axis, the wedge 
length represents the distance between the contact points of the wedge.

Width 
Enter a value indicating the actual width of the wedge.
For a cylindrical part with a curvature along the secondary axis, the wedge 
width represents the distance between the contact points of the wedge.

Height 
Enter a value indicating the actual height of the wedge model.
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Wedge angle1 
Enter a value in degrees indicating the angle of the wedge.
The wedge angle is the angle between the element surface (when it is fixed onto 
the wedge) and the surface of the part (or the tangential plane in relation to 
the surface of the part in the case of a cylindrical geometry). This angle is 
obtained upon rotation around the secondary axis of the probe, and it can 
have values between 0° and 89.9°.

Velocity1

Enter a value in meters per second or inches per microsecond (m/s or in./μs) 
indicating the ultrasound longitudinal-wave velocity in the wedge.

Pocket depth 
Enter a value indicating the pocket depth of the wedge perpendicular to the 
probe surface.

Roof angle1 
Enter a value in degrees indicating the roof angle of the wedge. The roof angle 
is the rotation angle around the primary axis of the probe set, and can have 
values between −89.9° and 89.9°. For a probe skew of 0°, a positive roof angle 
will generate beams with total skew angles between 0° and 180°.

An inspection setup that contains a wedge with a roof angle value other than 0 (zero) 
can only be exported as a .law file. For more information, see “Exporting a Workspace 
as a .law File” on page 164.

1.  For a predefined wedge model, when a wedge series of the Immersion type is selected, the Wedge 
angle, Velocity, Roof angle, Primary offset, Height (1st element), and Fluid parameters become 
editable.
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Damping
Select the Damping check box to show the damping material on the wedge. 
Clear the Damping check box to hide the damping material on the wedge.

Forward area
Select the Forward check box to specify that the probe can be mounted with its 
primary axis pointing in the same direction as the probe set’s primary axis, which 
indicates that the probe has a zero-degree (0°) orientation on the wedge.
The following parameters can be configured for the probe location on the wedge:

Primary offset1 
Enter a value indicating the primary axis offset at the middle of the first 
element of the probe-set probe relative to the back of the wedge, with a 0° 
orientation on the wedge. The offset is always measured along a straight line 
and normally has positive values.

Height (1st element)1 
Enter a value indicating the height (tertiary offset) at the middle of the first 
element of the probe-set probe relative to the material surface, with a 0° 
orientation on the wedge (see Figure 9-22 on page 128).

Figure 9-22  The height of the first element

1.  For a predefined wedge model, when a wedge series of the Immersion type is selected, the Wedge 
angle, Velocity, Roof angle, Primary offset, Height (1st element), and Fluid parameters become 
editable.

1.0 cm
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For a cylindrical part, the height is measured relative to the flat wedge surface 
obtained by drawing a line between the contact points of the wedge, and its 
value is always positive.
This parameter is usually provided by the wedge manufacturer.

Reverse area
Select the Reverse check box to specify that the probe can be mounted with its 
primary axis pointing in the opposite direction of the probe set’s primary axis, 
which indicates that the probe has a 180° orientation on the wedge:

Primary offset 
Enter a value indicating the primary axis offset of the middle of the first 
reverse element of the probe-set probe relative to the back of the wedge, with 
a 180° orientation on the wedge. The offset is always measured along a 
straight line, and normally has positive values.

Height (1st element) 
Enter a value indicating the height (tertiary offset) of the middle of the first 
reverse element of the probe-set probe relative to the material surface, with a 
180° orientation on the wedge (see Figure 9-22 on page 128).
For a cylindrical part, the height is measured relative to the flat wedge surface 
obtained by drawing a line between the contact points of the wedge, and this 
value is always positive.
This parameter is usually provided by the wedge manufacturer.

The Reverse column’s check box is only available for certain series of wedges. Refer to 
your probes’ and/or wedges’ technical specifications to verify whether the probes can 
be reversed when mounted on the wedges.
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9.5.11 Configuring Probe-Set Position Parameters

Several probe-set position parameters for custom wedge models are defined 
according to specific probe conventions.

To configure probe-set position parameters

 On the Probe Sets tab, under Position, configure the following parameters to 
position the probe set relative to the weld to be inspected:

Reverse column ( )
Under Reverse, select the check box to mount the probe backwards on the 
wedge (see Figure 9-23 on page 130), to reverse the position of the probe on 
the wedge, and to invert the order of the element numbers in the calculation 
of the beams (focal laws). When the Reverse column check box is selected, the 
lowest element is attributed the highest element number.

Figure 9-23  Example of a probe mounted backwards on a wedge

The Reverse column check box is only available for some series of wedges. Refer to 
your probes’ and/or wedges’ technical specifications to verify whether the probes can 
be reversed when mounted on the wedges.

Probe-Set Skew Angle column ( )
In the list under Probe-Set Skew Angle, select the angle of the ultrasonic 
beam relative to the scan axis. The available options are: 0°, 90°, 180°, and 270° 
(see Figure 9-24 on page 131).
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Figure 9-24  Examples of available probe-set angles

The probe-set skew angle is defined as the angle between the primary axis of the 
probe set and the plane defined by the scan axis and the ultrasound axis. The 
skew has a value of 0° when the beam direction points parallel to the scan axis 
in the positive direction. The skew angle increases in the clockwise direction.

Probe-Set Scan Offset column ( )
In the box under Probe-Set Scan Offset, enter the scan offset of the probe set. 
The probe-set scan offset represents the distance between the probe set’s 
primary axis and the origin of the scan axis (see Figure 9-25 on page 131), or 
the distance on the scan axis between the actual beam emergence point of the 
probe set and the reference point on the probe.

Figure 9-25  Probe-set scan offset

Probe-Set Index Offset column ( )
In the box under Probe-Set Index Offset, enter the mechanical index offset of 
the probe set. The probe-set index offset represents the distance between the 
front of the wedge and the origin of the index axis (see Figure 9-26 on 
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page 132), or the distance on the index axis between the actual beam 
emergence point of the probe and the reference point of the probe.

Figure 9-26  Probe-set index offset

Probe Center Separation (PCS) column ( )
In the box under Probe Center Separation (PCS), enter the PCS distance of 
the selected TOFD probe set (see Figure 9-27 on page 132). The PCS is defined 
as the distance between the beam exit points of the two probes of a TOFD 
probe set.

Figure 9-27  Probe center separation measurement

The values of the Probe-Set Scan Offset, Probe-Set Index Offset, and Probe Center 
Separation (PCS) parameters can be interactively modified using controls on the 
toolbar from RayTracing view. For more information, see “Interactively Modifying 
Probe Parameter Values” on page 47.
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9.5.12 Setting Up the Probe-Set Hardware Connection

The Hardware Connection section on the Probe Sets tab provides parameters that 
can be used to identify the first wired element of the pulser group and the first wired 
element of the receiver group on the probe-set probes.

For more information about probe-set pulser and receiver elements, see “Physical 
Principles” on page 173.

To set up the probe-set hardware connection

 On the Probe Sets tab, under Hardware Connection, configure the following 
parameters in order to identify the first element of the pulser and/or receiver 
group on the probe-set probes:

Pulser column ( )
In the list under Pulser, select the channel number of the acquisition unit to be 
connected to the pulsing probe’s first element (see Figure 9-28 on page 133). 
By default, for a PA linear or dual matrix probe set, element 1 is selected in 
the list.
For a UT or TOFD probe set, channel P1 is selected in the list. The values that 
contain a P (P1, P2, etc.) identify pulser channels instead of probe elements.

Figure 9-28  Pulsing probe with first element marked in yellow

When the pulsing probe and the receiving probe are the same, the receiver 
channel is identical to the pulser channel.

Receiver column( )
In the list under Receiver, select the channel number of the acquisition unit to 
be connected to the receiving probe’s first element (see Figure 9-29 on 
page 134).
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For a TOFD probe set, channel R1 is selected in the list. The values that 
contain a P (P1, P2, etc.) identify pulser channels instead of probe elements. 
The values that contain an R (R1, R2, etc.) identify receiver channels instead of 
probe elements. When a channel has been selected in the Pulser column list, it 
is not available in the Receiver column list.

Figure 9-29  Receiving probe with the first element marked in yellow

When the pulsing probe and receiving probe are the same, the receiver 
channel is identical to the pulser channel.
The Receiver column list is unavailable when the probe type selected is PA 
Linear or UT.

When using only one probe, you should set the value of these parameters to 1 (see 
Figure 9-30 on page 134).

Figure 9-30  Example pulser and receiver configuration for a single probe

Use the Pulser and Receiver column parameters when:

• Two UT probes will be connected in a symmetric configuration for measurement.
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• Two phased array probes will be connected to a splitter box (such as the OMNI-A-
ADP05 shown in Figure 9-31 on page 135) for measurement in a symmetric 
configuration.

Figure 9-31  Example pulser and receiver configuration for two 128-element probes

In this case, you need to separately calculate the beams for each probe using the 
same values for all the NDT SetupBuilder parameters, with the exception of the 
Pulser connection and Receiver connection parameters. The Pulser connection 
and Receiver connection parameters for a given probe must have the same value. 
If you are working with 128-element probes, the value can be set between 1 and 64 
for the first probe and between 65 and 128 for the second probe (see Figure 9-31 
on page 135).

In the case of TOFD probes, you need to connect the pulser and receiver on different 
connectors and note the element numbers used in the respective parameters.
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10. Configuring One or More Groups

In NDT SetupBuilder, the groups used in an inspection setup are configured on the 
Groups tab. The Groups tab provides tools and parameters for modifying groups that 
were automatically created with probe sets, creating and configuring new groups, 
deleting groups, and setting group visibility.

Before adding groups to your inspection setup on the Groups tab, you must create the 
required probe sets using the Probe Sets tab. When creating a group, you are required 
to select a probe set from the list of currently available probe sets in your workspace. 
For more information, see “Adding a Probe Set” on page 92.

The group’s width is measured at the 6 dB attenuation level. As such, the beam spread 
at −6 dB is displayed in RayTracing view. The beam overlap displayed in RayTracing 
view for a TOFD probe set is also −6 dB.

The Groups tab contains a toolbar that provides basic beam-definition commands 
(see Figure 10-1 on page 138).

Several of the Groups tab’s commands can be activated using keyboard shortcuts. For 
more information, see “Accessing Commands Using Keyboard Shortcuts” on page 31.
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Figure 10-1  Groups tab toolbar

The Groups tab columns provide parameters that can be used to configure the group 
visibility, angles, elements, and focusing.

On the Groups tab, point the mouse to each column header or toolbar element to 
display a tooltip with a short description of the pertaining parameter or function.

The groups being configured for an inspection setup can be viewed in 2-D or 3-D in 
RayTracing view, except for groups associated with probe sets of the dual matrix type, 
which are only displayed in End (D) view. For more information, see “RayTracing 
View” on page 40.

When you select a group on the Groups tab, the probe set it is associated with is 
highlighted in RayTracing view. For more information, see “Identifying Selected 
Probe Sets in RayTracing View” on page 32.

The tools needed to configure the probe sets associated with the groups can be found 
on the Probe Sets tab. For more information about configuring groups, see 
“Configuring One or More Probe Sets” on page 91.

10.1 Adding a Group

For probe sets of the PA linear or dual matrix type, the Groups tab toolbar can be used 
to add one or more groups in an inspection setup. Groups cannot be added to probe 
sets of the TOFD or UT types, each of which are created with an associated group.

Add Group 
button

Delete 
Group button

Clone Group 
button

Near Field 
Distance 
button

Beam 
Formation 

button

Active Beam 
list
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Before being able to add groups to your inspection setup on the Groups tab, you must 
have created the required PA linear- or dual matrix-type probe sets on the Probe Sets 
tab. When creating a group, you are required to select a probe set from the list of 
currently available probe sets in your workspace. For more information, see “Adding 
a Probe Set” on page 92.

To add a group

1. Click the Groups tab.

2. Click the Add Group button ( ) on the toolbar, and then select the desired PA 
linear- or dual matrix-type probe set in the list that appears immediately below 
the Add Group button (see Figure 10-2 on page 139).

Figure 10-2  The Add Probe button with the Probe Sets list displayed

A new group is added to the Groups tab table. This table can be used to configure 
or modify the available group definition parameters. However, the probe set 
associated with the group cannot be changed after it has been created. For more 
information, see “Configuring the Parameters of Groups” on page 145.

10.2 Deleting a Group

For probe sets of the PA linear or dual matrix type, the Groups tab toolbar can be used 
to delete one or more groups in an inspection setup. The groups associated with probe 
sets of the TOFD or UT type cannot be deleted.

To delete a group

1. In the list under the Groups tab, select one or more groups you want to delete (see 
Figure 10-3 on page 140).

The Add Probe button with the
list of PA linear- and dual matrix-

type probe sets available for
selection
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Figure 10-3  Selecting a group on the Groups tab for deletion

2. Click the Remove Group button ( ) on the Groups tab toolbar.
The selected groups are deleted from the list of groups on the Groups tab.

10.3 Cloning a Group

For probe sets of the PA linear or dual matrix type, the Groups tab toolbar can be used 
to clone one or more groups in an inspection setup. The groups associated with probe 
sets of the TOFD or UT types cannot be cloned.

To clone a group

1. In the list under the Groups tab, select one or more groups you want to clone (see 
Figure 10-4 on page 140).

Figure 10-4  Selecting a group on the Groups tab for cloning
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2. Click the Clone Group button ( ) on the Groups tab toolbar.
The cloned groups are added to the list of groups on the Groups tab.

10.4 Setting a Group’s Near-Field Visibility

The Groups tab toolbar can be used to set the visibility of a group’s near field. The 

Near Field Distance button ( ) is used to toggle a function that displays the near 
fields of all the groups visible in RayTracing view (see Figure 10-5 on page 141).

Figure 10-5  Near-field visibility examples

Only within an inspection setup configured for a plate part, the near field for groups 
associated to probe-sets of the PA linear, TOFD or UT types can be displayed. When 
an inspection setup is configured for a tube or bar part, the near field for groups 
cannot be displayed.

The near-field visibility is set in RayTracing view simultaneously for all the visible 
groups of compatible inspection setup configurations.

Group in RayTracing view with near-field visibility 
off (default)

Group in RayTracing view with near-field visibility on
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To set a group’s near-field visibility

 Click the Near Field Distance button ( ) on the Groups tab toolbar.
Dots are displayed on the beams of all the visible groups in RayTracing view, with 
the end of the near field displayed for each beam. The Near Field Distance button 
toggles the beams’ near-field visibility on and off.

10.5 Setting Beam (Focal Law) Formation Visibility for a Group

The Groups tab toolbar can be used to set the visibility of beam formation (the focal 

laws) for a group. The Beam Formation button ( ) is used to toggle a function that 
displays either all of the beams from a group or one of the beams that form that group 
in RayTracing view (see Figure 10-6 on page 142).

Figure 10-6  Group visibility examples

Only within an inspection setup configured for a plate part, the beam formation 
visibility for groups associated to probe-sets of the PA linear or dual matrix types can 
be configured. When an inspection setup is configured for a tube or bar part, the beam 
formation for groups cannot be configured.

RayTracing view with beam (focal law) formation 
visibility off (default).

RayTracing view with beam (focal law) formation 
visibility on.
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The beam formation is set in RayTracing view for only one group at a time for groups 
of compatible inspection setup configurations.

To set the beam-formation visibility of a group

1. In the list under the Groups tab, select the group for which you want to set the 
beam-formation visibility (see Figure 10-7 on page 143).

Figure 10-7  Setting the beam-formation visibility on the Groups tab

2. Click the Beam Formation button ( ) on the Groups tab toolbar. The Beam 
Formation button toggles the beam-formation visibility on and off.
When more than one beam is generated for the group, the Active Beam list to the 
right of the Beam Formation button becomes available (see Figure 10-8 on 
page 143).

Figure 10-8  Selecting the displayed beam in the Active Beam list
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3. From the Active Beam list, select the angle of the beam to be displayed in 
RayTracing view.

10.6 Setting Group Visibility

On the Groups tab, a group’s visibility can be set independently from the probe-set 

visibility by using the check box in the Visible column ( ) on the left-hand side of 
the parameter table (see Figure 10-9 on page 144). By default, a group is visible upon 
creation.

When you hide a probe set, all of the groups associated with it are automatically 
hidden. Visibility can only be set for the groups of a visible probe set. For more 
information about setting a probe set’s visibility, see “Setting Probe-Set Visibility” on 
page 97.

Figure 10-9  The Groups tab with a group’s visibility check box selected (in the far-
left column)
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To set group visibility

1. In the list under the Groups tab, select the group for which you want to set the 
visibility (see Figure 10-9 on page 144).

2. Perform one of the following actions:
— To show the group in RayTracing view, select the check box under Visible 

( ).
The group is displayed in RayTracing view.

— To hide the group in RayTracing view, clear the check box under Visible 

( ).
The group is hidden in RayTracing view (Figure 10-10 on page 145).

Figure 10-10  The Groups tab with a group’s visibility check box cleared

10.7 Configuring the Parameters of Groups

When defining or modifying a group on the Groups tab, the available parameters 
identified on the tab’s column headers can also be configured (see Figure 10-11 on 
page 146).
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Figure 10-11  The Groups tab column headers

To configure the parameters of groups

1. From the Groups tab list, select the group you want to configure (see Figure 10-12 
on page 146).

Figure 10-12  Selecting a group on the Groups tab for configuring parameters

2. On the left-hand side of the parameters table, set the group visibility and display 
color parameters. For more information, see “Setting the Group Visibility and 
Display Parameters” on page 147.

3. In the Group section, configure the group parameters. For more information, see 
“Configuring the Group Section Parameters” on page 148.

4. In the Refracted Angle section, configure the group refracted angle parameters. 
For more information, see “Configuring Refracted Angle Parameters” on 
page 149.

5. In the Skew Angle section, configure the group skew angle parameters. For more 
information, see “Configuring Skew Angle Parameters” on page 152.
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6. In the Elements section, configure the group element step and element quantity 
(aperture) parameters. For more information, see “Configuring Element 
Parameters” on page 154.

7. In the Focusing section, configure the group focusing parameters. For more 
information, see “Configuring Focusing Parameters” on page 157.

10.7.1 Setting the Group Visibility and Display Parameters

The group visibility and display parameters can be set on the left-hand side of the 
Groups tab for the selected group.

To set the group visibility and display parameters

 On the Groups tab, on the left-hand side of the parameter table, set the group 
visibility and display color:

Visible column ( )

In the Visible column ( ) box, select or clear the check box to show or hide 
the group in RayTracing view. The visibility of the group is set independently 
from the probe-set visibility. For more information about setting probe-set 
visibility, see “Setting Probe-Set Visibility” on page 97.

Visibility cannot be set for the groups of an invisible probe set.

Color column ( )
In the Color column list, click the color indicator to display the color picker, 
and then select the group’s color in RayTracing view (see Figure 10-13 on 
page 148). The default color for a group is blue.

NOTE
Configuring One or More Groups

 
147



DMTA-20090-01EN, Rev. B, September 2022
Figure 10-13  Color column’s color picker

10.7.2 Configuring the Group Section Parameters

The Groups tab can be used to configure the group parameters in the Group section.

To configure group parameters

 In the Group section, configure the following parameters:
Name column

In the Name column box, type the name of the group. By default, the name 
New n is displayed.

Probe column ( )
In the Probe column box, the name of the probe set associated with the group 
is displayed.
The probe set associated with a group cannot be changed. A probe set of the 
PA linear or dual matrix type is associated with a group at the time of the 
group’s creation. A group is automatically created and associated with a 
probe set of the TOFD or UT type.

Group Type column ( )
In the Group Type column list, select the appropriate type for the group. The 
following options are available:

○  Linear

○  Sectorial

○  Compound
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○  Single
Depending on the probe-set type selected in the Probe column list, the 
options available in the list change as follows:
○ PA: Linear, Sectorial, Compound, and Single
○ TOFD: Single
○ UT: Single
○ Dual Matrix: Sectorial

Wave Type column ( )
In the Wave Type column list, select the wave type for the group: LW or SW 
(see Figure 10-14 on page 149).

Figure 10-14  LW wave-type and SW wave-type representations

When a probe set of the TOFD type is selected for a group, LW is selected by 
default in the list, and SW is also available for selection.
For probe sets of the PA linear or UT type, SW is selected by default, and LW 
is also available for selection.
When a probe set of the dual matrix type is selected for a group, LW is 
selected by default in the list, and it is the only option available.

10.7.3 Configuring Refracted Angle Parameters

The Groups tab can be used to configure the group refracted angle parameters in the 
Refracted Angle section.

To configure group refracted angle parameters

 In the Group section, configure the following parameters:

LW wave type icon SW wave type icon
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Refracted Angle Start column ( )
In the Refracted Angle Start column box, configure the angle of the first 
beam of the group (see Figure 10-15 on page 150). By default, the value is 45° 
for probe sets of the PA linear or dual matrix type.

Figure 10-15  Refracted angle start measurement

For probe sets of the PA linear or dual matrix type, the value can also be 
edited. When the start refracted angle value is confirmed, the value in the 
Refracted Angle Stop column box is automatically updated if required, as 
follows:
○ If the start angle value is greater than the stop angle value, the stop angle 

value is updated to equal the start angle value.
○ If steps have been configured, they are added to the start angle value, so 

the updated stop angle value is closest to, but no greater than, the 
currently set stop angle value. For example, for a start angle value set to 
20°, a stop angle value of 21°, and steps of 0.3°, the angles will be 20°, 
20.3°, 20.6°, and 20.9°.

When the stop angle value is automatically updated, it is always calculated 
from the last one computed. If you modify the start angle value several times, 
the values computed between the start angle and stop angle values will drift 
toward the start angle value.

For probe sets of the UT or TOFD type, the start refracted angle value is computed 
internally according to the probe set’s wedge angle and the inspected part’s material 
velocity by means of Snell’s law. However, the start refracted angle value is not 
displayed, and the Refracted Angle Start box is not available.
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Refracted Angle Stop column ( )
In the Refracted Angle Stop column box, configure the angle of the last beam 
of the group (see Figure 10-16 on page 151). By default, the value is 70° for 
probe sets of the PA linear or dual matrix type.

Figure 10-16  Refracted angle stop measurement

For probe sets of the UT or TOFD type, or for linear or single beam sets, the Refracted 
Angle Stop column box is unavailable.

For probe sets of the PA linear or dual matrix type, the value can also be 
edited. When the stop refracted angle value is confirmed, the angle value in 
the Refracted Angle Start column box is automatically updated if required, 
as follows:
○ If the start angle value is greater than the stop angle value, the start angle 

value is updated to equal the stop angle value.
○ If steps have been configured, they are subtracted from the stop angle 

value. As such, the updated start angle value is closest to, but not smaller 
than, the currently set value. For example, for a start angle value set to 
20°, a stop angle value of 21°, and steps of 0.3°, the angles will be 20°, 
20.3°, 20.6°, and 20.9°.

When the start angle value is updated, it is always calculated from the last 
computed start angle value. If you modify the stop refracted angle value 
several times, the values computed between the start angle and stop angle 
values will drift toward the stop angle value.

Refracted Angle Step column ( )
In the Refracted Angle Step column box, configure the angle of a sectorial 
group that is to be used as the stepping value to create all the beams in the 
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group (see Figure 10-17 on page 152). The Refracted Angle Step column box 
is not available for single type groups.

Figure 10-17  Refracted angle resolution

For a sectorial or a compound group, this value represents the angle that must 
be added to create each beam from the start refracted angle to the stop 
refracted angle. For a linear group, this value represents the number of 
elements that must be added to the center of each beam in order to create the 
next beam in the group. The default value is 1.0.

10.7.4 Configuring Skew Angle Parameters

When the selected probe-set type is dual matrix, the Groups tab can be used to 
configure the skew angle parameters in the Skew Angle section.

For PA linear, TOFD, and UT probe-set types, the Skew Angle section is unavailable. 
Also, the Skew Angle section is unavailable for some dual matrix probe 
configurations (for example, A27 with 2 × 16 elements).

To configure group skew angle parameters

 From the Skew Angle section, configure the following parameters:

Skew Start column ( )
In the Skew Start column box, configure the skew angle value for the first 
beam of the group (see Figure 10-18 on page 153). The default value is 0° (zero 
degrees).
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Figure 10-18  Start skew angle

When the skew start angle value is confirmed, the value in the Skew Stop 
column box is automatically updated if required, as follows: if the stop angle 
value is lower than the start angle value, the skew stop angle value is updated 
to equal the skew start angle value.

Skew Stop column ( )
In the Skew Stop column box, configure the stop skew angle value for the last 
beam of the group (see Figure 10-19 on page 153). The default value is zero 
degrees (0°).

Figure 10-19  Stop skew angle

When the stop skew angle value is confirmed, the value in the Refracted 
Angle Start column box is automatically updated if required, as follows: if 
the start skew angle value is greater than the stop skew angle value, the start 
skew angle value is updated to equal the stop skew angle value.

Skew Step column ( )
From the Skew Step column box, configure the skew angle value between the 
beams in the group (see Figure 10-20 on page 154). The skew angle step value 
is added to the start skew angle or each generated beam, up to the stop skew 
angle. The default value is 5°.
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Figure 10-20  Skew angle step

10.7.5 Configuring Element Parameters

On the Groups tab, the element parameters can be configured in the Elements 
section.

To configure group element parameters

 In the Elements section, configure the following parameters:

First Element column ( )
In the First Element column box, select the number of the first element to be 
used for the first beam (the first focal law) of the group (see Figure 10-21 on 
page 154). The default value is 1.

Figure 10-21  The first element displayed in yellow

When the first element value is modified, the last element value in the Last 
Element column box is automatically updated if required, as follows:
○ If the first element value is greater than the last element value, the last 

element value is updated to equal the first element value.
○ If steps have been configured, they are added to the first element value. 

As such, the updated last element value is closest to, but not smaller than, 
the currently set value. For example, if the first element value is set to 1, 
the last element value is set to 6, and the step value is set to 2 elements, 
the start elements will be 1, 3, and 5.
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For a group of the linear type, when the value in the First Element column 
box is modified, the value in the Element Quantity column box is 
automatically updated if required. If adding the element quantity (aperture) 
value to the first element value results in a last element value greater than the 
currently configured last element value, the element quantity value is 
automatically reduced to correspond to the configured last element value. 
When the last element value is updated, it is always calculated based on the 
last computed value. If you modify the first element value several times, the 
values computed for the last element value will drift toward the first element 
value.

For dual matrix groups, the value of the First Element parameter depends on the 
probe element configuration. If a probe configuration is 4 × 7, the First Element 
parameter is 1, 8, 15, or 22.

Last Element column ( )
For a group of the linear type, in the Last Element column box, select the 
number of the last element to be used for the last beam (focal law) of the 
group (see Figure 10-22 on page 155). The default value is 16. The Last 
Element column box is not available for a group of the Sectorial or Single 
type.

Figure 10-22  The last element displayed in yellow

When the last element value is modified, the first element value in the First 
Element column box is automatically updated if required, as follows:
○ If the first element value is greater than the last element value, the first 

element value is updated to equal the last element value.
○ If steps have been configured, they are subtracted from the last element 

value. As such, the updated first element value is closest to, but not 
smaller than, the currently set value.
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When the value in the First Element column box is modified, the value in the 
Element Quantity column box is automatically updated if required. If adding 
the element quantity (aperture) value to the first element value results in a 
last element value greater than the currently configured last element value, 
the element quantity value is automatically reduced to correspond to the 
configured last element value.
When the last element value is updated, it is always calculated from the last 
computed value. If you modify the first element value several times, the 
values computed will drift toward the last element value.

Element Step column ( )
For a group of the PA linear type, in the Element Step column box, configure 
the element step value, the number of elements between the first element of a 
beam (focal law), and the first element of the next beam in the group (see 
Figure 10-23 on page 156). The element step value is added to the start 
element for each beam (focal law) generated.

Figure 10-23  The element step between the first elements of beams

Element Quantity column ( )
In the Element Quantity column box, select the number of elements that 
comprise the element quantity (aperture) for the beams (focal laws) of the 
group (see Figure 10-24 on page 156). The default value is 16 elements.

Figure 10-24  The element quantity

The element quantity value is combined with the step, the first element, and 
the last element values to generate the beams (focal laws) for the group.
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For a group of the linear type, when the value in the First Element column 
box is modified, the value in the Element Quantity column box is 
automatically updated if required. If adding the element quantity value to the 
first element value results in a last element value greater than the currently 
configured value, the element quantity value is automatically reduced to 
correspond to the configured last element value.

For dual matrix groups, the value of the Element Quantity parameter depends on the 
probe element configuration. If a probe configuration is 4 × 7, the Element Quantity 
parameter is 7, 14, 21, or 28.

10.7.6 Configuring Focusing Parameters

The Focusing section on the Groups tab can be used to configure the group 
parameters.

To configure group focusing parameters

 In the Focusing section, configure the following parameters:

Distance column ( )
In the Distance column box, configure the distance (in true depth for a plate part 
or in half path for a tube or a bar part) at which the beams (focal laws) that form 
the group will intersect; in other words, the distance at which focusing should 
occur (see Figure 10-25 on page 157).

Figure 10-25  Focusing distance
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This focusing distance is defined based on the type selected in the Focusing 
Type column. The default value is 50 mm with the true-depth focusing type 
for a group associated with a probe set of the PA linear type.

Beam focus points are displayed as green dots in RayTracing view (see Figure 10-26 
on page 158).

Figure 10-26  Example of beam focus points represented in RayTracing view

Focusing Type column ( )
In the Focusing Type column box, choose one of the three available types of 
focusing distance measurement: True depth (mm or in.), True depth (% of 
thickness), or Half path (see Figure 10-27 on page 159).

NOTE

Group Beam focus points (green dots)
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Figure 10-27  Focusing type

Legs column ( )
In the Legs column box, configure the number of legs, or half skips, that are 
displayed in RayTracing view for the group (see Figure 10-28 on page 159 and 
Figure 10-29 on page 159).

Figure 10-28  Legs

Figure 10-29  The legs for groups of two probe sets with 90° and 270° skew angles

True depth Half path

Leg 1

Weld

Leg 2 Leg 2 Leg 1
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The default value is 2 legs for groups associated with probe sets of the PA 
linear and UT types, and 1 leg for groups associated with probe sets of the 
TOFD and dual matrix types.

For probe sets of the TOFD and dual matrix types, the Legs column box value cannot 
be modified.
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11. Exporting Setup Files to an OmniScan Instrument

In order to efficiently manage inspection setups for OmniScan instruments, setup files 
can be exported from NDT SetupBuilder to OmniScan MX2 and OmniScan SX 
instruments.

To export setup files from NDT SetupBuilder to an OmniScan, the computer must be 
equipped with either a USB port or an internal or external SD card reader.

The workspace configuration can be exported in one of the following two formats:

• Connectivity (.ondtsetup)
The resulting connectivity file contains the group configurations from the NDT 
SetupBuilder workspace file, which can be imported into an OmniScan 
instrument. The groups are then converted into groups in the OmniScan. The 
beams (focal laws) are automatically calculated according to the hardware 
available in the OmniScan.
For more information about exporting a connectivity file from your workspace, 
see “Exporting a Workspace As a Connectivity File” on page 162.

• LAW (.law)
The resulting .law file contains the group configurations from the NDT 
SetupBuilder workspace file, which can be imported into an OmniScan 
instrument.
To create a .law file, your NDT SetupBuilder workspace file must contain at least 
one PA linear probe set and one PA linear group. For more information about the 
.law file format, see “Description of the .law File Format” on page 179.
For more information about exporting .law files from your workspace, see 
“Exporting a Workspace as a .law File” on page 164.

The setup file can be saved on a USB key or SD card. The media file containing the 
setup file you want to import is then inserted into the OmniScan.
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When a workspace configuration is not supported by the OmniScan (such as long 
seam, compound scan, dual matrix, or PA linear pitch-catch), NDT SetupBuilder 
allows files to be exported in the .law format. In such case, this is the only available 
option, because the export to connectivity option is disabled.

11.1 Exporting a Workspace As a Connectivity File

Your workspace can be exported from NDT SetupBuilder as a connectivity file, which 
has the .ondtsetup extension. The exported file can then be imported into an 
OmniScan instrument using a USB key or SD card. On import into the OmniScan, the 
parameters configured in the workspace are verified. If the configured parameters are 
valid, they are computed and groups are generated.

Only visible groups associated with visible probe sets are exported. The entire setup 
configuration will be verified and computed after being imported into an OmniScan 
instrument. At this stage, the configuration may be declared invalid if it is not entirely 
supported by the OmniScan.

For more information about importing .ondtsetup files to the OmniScan, refer to the 
user’s manual for the OmniScan MXU 3.2 software, or a more recent version.

Only a limited number of inspection setup configurations are supported within NDT 
SetupBuilder for exporting an inspection setup as a connectivity file. For more 
information, see Table 9 on page 163.
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If an inspection setup contains deactivated probe elements or a wedge with a roof 
angle value other than 0 (zero), it can only be exported to an OmniScan instrument as 
one or more .law files. For more information on exporting a setup as a .law file, see 
“Exporting a Workspace as a .law File” on page 164.

Table 9  Supported setup configurations for exporting to MXU 3.2 software using 
connectivity files 

Probe skew PA lineara

a. Single, linear, and sectorial scans

UT TOFD Focusing (true 
depth)b

b. When a connectivity .ondtsetup file that was exported from an inspection 
setup is imported in an OmniScan instrument, only true depth focusing is 
supported.

Plate inspection
0°    
90°    

180°    
270°    

Pipe and bar — circumferential inspection
0° — — — —
90°    

180° — — — —
270°    

Pipe and bar — axial inspection
0°    
90° — — — —

180°    
270° — — — —
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For more information about deactivating probe elements, see “Deactivating and 
Activating Phased Array Probe Elements” on page 110.

For more information about configuring a roof angle on a custom wedge, see 
“Configuring Custom Wedge Model Parameters” on page 124.

To export a workspace as an .ondtsetup file

1. On the File menu, point to Export, and then click Connectivity.
2. In the Save As dialog box, choose the folder where you want to save the file (see 

figure Figure 11-1 on page 164).
3. Click Save.

Figure 11-1  The Save As dialog box when saving a workspace as an .ondtsetup file

11.2 Exporting a Workspace as a .law File

NDT SetupBuilder can be used to export groups from your workspace into a .law file. 
The exported file can then be imported into an OmniScan instrument using a USB key 
or SD card. The groups imported into an OmniScan can be executed without the need 
for additional computation within the instrument, making it possible to conduct 
inspections that OmniScan instruments cannot perform natively.
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To export a group, it must be selected in the Groups tab, following which it will be 
exported as a .law file. For more information about the .law file format, see 
“Description of the .law File Format” on page 179.

The following parameters are set using the following values:

• Channel gain: 0
• Voltage: 40
• Channel pulse width: 50
• Cycles: 1
• Filter: 0

NDT SetupBuilder automatically creates the file name, which is the name of the 
selected group.

For more information about importing a .law file to the OmniScan, refer to the user’s 
manual for the OmniScan MXU 3.2 software, or a more recent version.

An inspection setup that contains deactivated probe elements or a wedge with a roof 
angle value other than 0 (zero) can only be sent to an OmniScan instrument as one or 
more .law files. For more information on exporting a setup as a .law file, see 
“Exporting a Workspace as a .law File” on page 164.

For more information about deactivating probe elements, see “Deactivating and 
Activating Phased Array Probe Elements” on page 110.

For more information about configuring a roof angle on a custom wedge, see 
“Configuring Custom Wedge Model Parameters” on page 124.

Only a limited number of inspection setup configurations are supported within NDT 
SetupBuilder for exporting an inspection setup as a .law file. For more information, 
see Table 10 on page 166.
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To export the current group as a .law file

1. On the File menu, point to Export, and then click Laws.
2. In the Save As dialog box, select the folder where you want to save the file (see 

Figure 11-1 on page 164).
3. Click Save.

Table 10  Supported setup configurations for exporting to MXU 3.2 software using 
.law files 

Probe 
skew

PA 
lineara

a. Single, linear, compound, and sectorial scans

UT TOFD Focusingb 

b. Half path and true depth

Element 
deactivation

Roof 
angle

Dual 
matrix

Plate inspection
0°       —
90°       

180°       —
270°       —

Pipe and bar — circumferential inspection
0°       —
90°       

180°       —
270°       —

Pipe and bar — axial inspection
0°       —
90°       —

180°       —
270°       —
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Figure 11-2  The Save As dialog box when saving a workspace as a .law file
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12. Generating Reports

NDT SetupBuilder allows you to generate an HTML report of your inspection setup, 
which is automatically displayed in your web browser. Reports generated by NDT 
SetupBuilder use the same format as reports generated by the OmniScan.

The report contains all the probe sets and groups of the inspection setup defined in 
the workspace.

To generate a report

 On the File menu, click Generate Report.

When generated, the report automatically opens in your default web browser (see 
Figure 12-1 on page 170). In the browser, you can save the report as an HTML or PDF 
file or send it to a printer.
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Figure 12-1  NDT SetupBuilder report displayed in Internet Explorer

When saving a report in HTML format in the Microsoft Internet Explorer web 
browser, in the Save Webpage dialog box, make sure that you select the Webpage 
HTML only (*.htm, *.html) option in the Save as type list (see Figure 12-2 on 
page 171).
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Figure 12-2  The Save Webpage dialog box from MS Internet Explorer

The images of your report that are displayed in the web browser are optimized for 
printing.
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Appendix A: Phased Array Technique

This section describes the main concepts relating to phased array inspection and 
phased array data views.

Phased array technology makes it possible to generate an ultrasonic beam and to 
modify ultrasonic beam parameters such as angle, focal distance, and focal spot size 
using software. For example, it is possible to quickly vary the angle of the ultrasonic 
sectorial beam in order to scan a part or weld without having to move the probe itself. 
Furthermore, this ultrasonic beam can be multiplexed over a large array, thus creating 
movement of the ultrasonic beam along the array.

Phased array capabilities also enable the replacement of multiple probes and 
mechanical scanning devices. Inspecting a part or weld with a variable-angle 
ultrasonic beam also improves detection, regardless of the defect orientation, and 
optimizes signal-to-noise ratio.

A.1 Physical Principles

To generate an ultrasonic beam, the various probe elements are pulsed at slightly 
different times. By precisely controlling the delays between the probe elements, 
ultrasonic beams of various angles, focal distances, and focal spot sizes can be 
produced. As shown in Figure A-1 on page 174, the echo from the desired focal point 
hits the various probe elements with a computable time shift. The echo signals 
received at each probe element are time-shifted before being summed together. The 
resulting sum is an A-scan that emphasizes the response from the desired focal point 
and attenuates various other echoes from other points in the material.
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Figure A-1  Emitting and receiving in a phased array system

A phased array probe is typically a one- or two-dimensional array of small probe 
elements. To control the ultrasonic beam characteristics, the excitation pulse is applied 
at different times to the various elements of the probe.

The phased array probe is composed of multiple elements that allow for ultrasonic 
beam angle control (see “Beam Angle Control” on page 174) and ultrasonic beam 
focus control (see “Beam Focus Control” on page 176).

A.1.1 Beam Angle Control

Beam angle control involves the production of a wave front. As shown in Figure A-2 
on page 175, simultaneous firing of all elements of a linear multielement probe 
produces a series of circular arc waves (one from each probe element). Because all 
wave fronts are at the same distance from their respective emitter, the resulting wave 
front, or envelope, is parallel to the probe plane. This is, in fact, very similar to pulsing 
a single element probe of the same size.

Acquisition Unit

Acquisition Unit

Phased Array 
Unit

Phased Array 
Unit

Probes

Flaw

Emitting

Receiving

Trigger

Pulses Incident wave front

Reflected wave front
Echo signals

Flaw
Appendix A

 
174



DMTA-20090-01EN, Rev. B, September 2022
Figure A-2  Ultrasonic wave front of a linear array

The phased array unit enables pulsing of the elements in a sequential manner with a 
small and precisely controlled time delay between each element. Sequential firing of 
the various probe elements produces a series of circular arc waves in a wave front, or 
envelope, that is no longer parallel to the probe surface, but that propagates at an 
angle (see Figure A-3 on page 175). The pulse delays can be adjusted to produce any 
desired wave-front angle.

Figure A-3  Ultrasonic beam angle control of a linear array
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A.1.2 Beam Focus Control

When generating a focused beam, the delays are adjusted so that all individual wave 
fronts stay in phase along the path leading to the desired focal point, while canceling 
each other out at all other points. By accurately controlling the pulse delays, it is 
possible to focus the beam at a desired point (see Figure A-4 on page 176).

Figure A-4  Ultrasonic beam focusing of a linear array

For beam angle control and beam focus control, signals received by every element are 
time-synchronized by the phased array system prior to summing the various 
responses.

A.2 Group Types

Phased array offers the possibility of performing inspections with various angles and 
focal lengths (focal length is referred to as focusing distance in NDT SetupBuilder).

The two types of groups used for phased array inspection are sectorial groups and 
linear groups.
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A.2.1 Sectorial Groups

For certain applications, conventional UT inspection would require use of a number 
of different probes, whereas a single phased array probe can be used to sequentially 
produce the various angles and focal points required by the application (see 
Figure A-5 on page 177).

Figure A-5  Ultrasonic beam angle control and focusing of a linear array

Sectorial scanning of the phased array signal is obtained by applying several beams in 
sequence at each X-Y coordinate of the inspected area.

At each X-Y coordinate of the inspection sequence, an array of elements is used to 
deflect the ultrasound beam without moving the probe. Scanning can be conducted 
along a horizontal axis (see Figure A-6 on page 178).
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Figure A-6  Sectorial scanning of X-axis using phased array deflection

A.2.2 Linear Groups

For large phased array probes containing a high number of elements, the phased 
array unit is capable of applying the same beam to different sets of elements. By 
moving the beam along a probe array, the scanning of an inspection axis is realized 
electronically without any need for physical displacement of the probe (see 
Figure A-7 on page 178).

Figure A-7  Electronic scanning along an axis

In Figure A-7 on page 178, a focused beam is created using a few of the many probe 
elements of a long phased array probe. The beam is then shifted (or multiplexed) to 
the other elements in order to perform a high-speed scan of the part with no probe 
movement along the scanning axis. More than one scan can be performed with 
various inspection angles.
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Appendix B: Description of the .law File Format

This appendix describes the .law file format used to create specific beam 
configurations. The .law file format is contained in text files that can be loaded 
directly in the OmniScan.

B.1 General Format

This section details the .law file format and provides examples for version 5.0 and 
version 5.2.

B.1.1 Format

This section describes the .law file format.

Law file version 5.0

The .law file format for version 5.0 is described as follows:

<Version> <Number of Laws>

<Number of Active Elements> <Unused1> <Unused2> <Sum Gain> <Unused3> <Unused4> 
<Refracted Angle> <Beam Skew Angle> <First Pulser> <First Receiver> <Scan 
Offset> <Index Offset> <Global Delay> <Focusing Depth> <Material Velocity>

<Element Number> <Beam Gain> <Transmission Delay> <Reception Delay> <Amplitude> 
<Pulse Width>

Law file version 5.2

The .law file format for version 5.2 is described as follows:
Description of the .law File Format

 
179



DMTA-20090-01EN, Rev. B, September 2022
<Version> <Number of Laws>

<Element Number> <Frequency> <Cycles> <Sum Gain> <Mode> <Filter> <Refracted 
Angle> <First Pulser> <First Receiver> <Scan Exit> <Index Exit> <Global 
Delay> <Focusing Depth> <Material Velocity> <Probe Skew Angle> <Beam Skew 
Angle>

B.1.2 Examples

Law file version 5.0

The following is an example of a .law file containing two beams of 10 elements each:

V5.0 2
16 300 1 -1 1 0 400 900 1 1 0 -46040 13869 50000 3240
1 0 570 570 40 100
2 0 539 539 40 100
3 0 508 508 40 100
4 0 475 475 40 100
5 0 442 442 40 100
6 0 407 407 40 100
7 0 372 372 40 100
8 0 335 335 40 100
9 0 297 297 40 100
10 0 258 258 40 100
11 0 218 218 40 100
12 0 176 176 40 100
13 0 134 134 40 100
14 0 90 90 40 100
15 0 46 46 40 100
16 0 0 0 40 100
16 300 1 -1 1 0 500 900 1 1 0 -44142 14282 50000 3240
1 0 175 175 40 100
2 0 168 168 40 100
3 0 161 161 40 100
4 0 153 153 40 100
5 0 145 145 40 100
6 0 136 136 40 100
7 0 126 126 40 100
8 0 115 115 40 100
9 0 103 103 40 100
10 0 91 91 40 100
11 0 78 78 40 100
12 0 64 64 40 100
13 0 49 49 40 100
14 0 34 34 40 100
15 0 17 17 40 100
16 0 0 0 40 100
Appendix B
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Law file version 5.2

The following is an example of a .law file for version 5.2:

V5.2 2
16 300 1 -1 1 0 400 1 1 -46040 0 13869 50000 3240 900 0
1 0 570 570 40 100
2 0 539 539 40 100
3 0 508 508 40 100
4 0 475 475 40 100
5 0 442 442 40 100
6 0 407 407 40 100
7 0 372 372 40 100
8 0 335 335 40 100
9 0 297 297 40 100
10 0 258 258 40 100
11 0 218 218 40 100
12 0 176 176 40 100
13 0 134 134 40 100
14 0 90 90 40 100
15 0 46 46 40 100
16 0 0 0 40 100
16 300 1 -1 1 0 500 1 1 -44142 0 14282 50000 3240 900 0
1 0 175 175 40 100
2 0 168 168 40 100
3 0 161 161 40 100
4 0 153 153 40 100
5 0 145 145 40 100
6 0 136 136 40 100
7 0 126 126 40 100
8 0 115 115 40 100
9 0 103 103 40 100
10 0 91 91 40 100
11 0 78 78 40 100
12 0 64 64 40 100
13 0 49 49 40 100
14 0 34 34 40 100
15 0 17 17 40 100
16 0 0 0 40 100

B.2 Object Description

The .law file object is defined by general parameters related to the file format and by 
law parameters related to the beams.
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B.2.1 General Parameters

The following general parameters are related to the .law file format:

Version
The version of the .law file in the following format: <V> <number> <ʹ.ʹ> <number>.

Number of Laws
The total number of beams defined in the file. This value ranges from 1 to 256.

B.2.2 Law Parameters

This section provides descriptions of the beam-related parameters in the .law file.

Number of Active Elements
The number of active elements used to generate a beam. This value ranges from 1 
to 32, and it is determined by the limits of the hardware.

Frequency
Pulse train frequency for the given law, in kilohertz. The default value 300 is not 
used. The value ranges from 300 to 2000. Used only for EMAT (electromagnetic 
acoustic transducer).

Cycles
The number of cycles in the pulse train for the given law. The default value is 1. 
The value ranges from 1 to 15. Used only for EMAT.

Unused1
Unused. Always set to 1000.

Unused2
Unused. Always set to 10.

Sum Gain
The gain working range for a given law, in decibels (dB). Sum Gain is an 
attenuation value that varies according to the number of active elements. This 
value is dependent on the instrument that is being used. The value −1 is the Auto 
Sum gain, which is defined by the hardware. The value ranges from −1 to 30.

Unused3
Unused. Always set to 0.
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Unused4
Unused. Always set to 0.

Mode
The inspection mode for the given law:

— 0 = T/R (transmit/receive), which has different pulser and receiver elements
— 1 = Pulse-echo, which has the same pulser and receiver elements

Filter
Specifies the filter applied at reception:

— 0 = no filter (0.5 MHz to 20 MHz)
— 1 = 0.5 MHz to 5 MHz
— 2 = 2.0 MHz to 10 MHz
— 3 = 5.0 MHz to 15 MHz

Refracted Angle
The refracted angle for the given law, expressed in tenths of degrees. The 
parameter-value range is as follows:

— For .law file version 5.0: 0 to 900.
— For .law file version 5.2: −900 to 900.

Beam Skew Angle
The skew angle for the given law, expressed in tenths of degrees. The parameter-
value range is as follows:

— For .law file version 5.0: 0 to 3599.
— For .law file version 5.2: −900 to 900.

The Beam Skew Angle is defined only for the beam, and initially assumes that the 
probe skew angle is 0. The probe skew angle (which determines the scan orientation) 
must be entered after the .law file is downloaded to the acquisition software.

Probe Skew Angle (version 5.2)
The probe skew angle for the given law, in degrees. The value ranges from 0 to 
3599.

NOTE
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First Pulser
Specifies the number of the first pulser hardware connection used for 
transmission during focal law formation (whether pulsing or not). The value is a 
positive integer determined by the hardware (instrument and probe).

First Receiver
Specifies the number of the first receiver hardware connection used during focal 
law formation (whether receiving or not). The value is a positive integer 
determined by the hardware (instrument and probe).

Scan Offset
The offset of the scan-axis exit point (for the given law) relative to the probe set’s 
origin (the mechanical reference point), expressed in micrometers.

Index Offset
The offset of the index-axis exit point (for the given law) relative to the probe set’s 
origin (the mechanical reference point), expressed in micrometers.

Global Delay
Specifies the global delay (GD) expressed in nanoseconds (ns). The value is a non-
negative integer, and is calculated as follows:
GD = ED + WD + LD
ED: electronic delay that is determined by the hardware. The value is 0 for 
OmniScan instruments.
WD: total wedge delay (transmission and reception).
LD: law delay (global delay introduced by the specified law).

Focusing Depth
Focusing distance, which is a true depth expressed in micrometers. The value is a 
non-negative integer.

Material Velocity
Specifies the propagation velocity in the material, in meters per second (m/s). The 
value is a non-negative integer.

Element Parameters
Parameters that are related to the individual elements in a defined beam.

Element Number
The number identifying the individual element of the phased array probe relative 
to the first pulser and the first receiver (see “First Pulser” on page 184 and “First 
Receiver” on page 184). The element numbers are consecutive (1, 2, 3, …). Inactive 
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elements are disabled by setting the Transmission Delay and Reception Delay to 
65535 (see “Transmission Delay” on page 185 and “Reception Delay” on 
page 185). The value must be less than or equal to the maximum number of 
hardware elements. The value is a positive integer.

Beam Gain
The gain applied to the considered beam, in decibels (dB). Admitted range: 0–80. 
Elements of the same beam must have the same focal law gain.

For .law files generated in offline mode (that is, without phased array equipment 
connected), this parameter has the default value 0.

Transmission Delay
Specifies the transmission delay for the specified active element. The delay is 
expressed in nanoseconds, and must be between 0 and 25600. The transmission is 
deactivated if 65535 is used.

Reception Delay
Specifies the reception delay for the specified active element. The delay is 
expressed in nanoseconds and must be between 0 and 25600. The reception is 
deactivated when 65535 is used.

Amplitude
The excitation amplitude for the specified active element, expressed in volts 
(range: 50–200). The value must the same for all elements of all beams defined in 
the current .law file.
For .law files generated in offline mode (that is, without phased array equipment 
connected), this parameter has the default value 180.

Pulse Width
The pulse-width value is applied to the specified active element, expressed in 
nanoseconds (range: 50–500). The value must be the same for all elements of all 
beams defined in the current .law file. Generally, the pulse width value can be 
confirmed as follows:
Pulse Width (ns) = 500 ÷ Probe Frequency (MHz)
Description of the .law File Format
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